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1 Introduction

Dans le livre d’Antonio Goncalves consacré a Java EE5', l'auteur illustre les principaux
concepts de JEE 5 au travers d'une application fictive baptisée Yaps Pet Store (ou Yaps pour
faire court). Cette application est elle-méme une émanation du Java Petstore de Sun issue du
programme Java BluePrints.

Le livre de référence couplé a I’application Yaps est un excellent support pédagogique pour
qui souhaite aborder et expérimenter le vaste sujet qu’est JEE 5.

Les sujets du livre de référence sont traités de maniere a construire pas a pas les différents
composants de l'application en abordant les principales spécifications de JEES : EJB, JPA,
IMS, JAX-WS, JavaMail, etc.

L'auteur a pris le parti d'étre indépendant d'un quelconque IDE. Des taches Ant sont utilisées
pour configurer I’environnement de travail, ainsi que pour construire et déployer les projets de
I’application.

Ce document a pour objectif de décrire les différentes étapes nécessaires pour porter
I’application Yaps sous I’IDE de Sun : NetBeans 6.5

Pourquoi NetBeans ?

Loin de nous I’idée de débattre entre tel ou tel IDE. Chaque IDE a ses forces et faiblesses. Le
plus important est que I’IDE choisi (Eclipse, NetBeans, IntelliJ, etc.) soit un moteur et non un
frein dans le processus d’industrialisation de logiciels.

Par ailleurs, connaitre plus d’un IDE est une valeur ajoutée. En tant que consultants
informatiques, nous sommes souvent amenés a adapter nos habitudes par rapport a
I’environnement de I’entreprise dans laquelle nous intervenons. Le choix des outils logiciels
est souvent dicté par des contraintes tant financiéres, techniques ou culturelles.

Dans le cas de notre entreprise, NetBeans est trés apprécié notamment pour sa couche SOA.
Les outils SOA intégrés a NetBeans ainsi que I’ESB (Enterprise Service Bus) OpenESB sont
excellents pour concevoir des prototypes applicatifs. Mais c’est un autre sujet que nous aurons
probablement I’occasion d’aborder dans le cadre d’un autre document.

NetBeans couplé a GlassFish est le partenaire idéal pour aborder les concepts JEES.
Et c’est justement 1’objectif de ce document.

A partir du livre de référence et de 1’application Yaps, nous allons importer I’ensemble des
projets sous NetBeans 6.5 pour obtenir un environnement complet et gratuit pour
expérimenter les différents sujets du livre et aller plus loin dans la découverte des concepts
entourant les spécifications JEE 5.

"'Voir [R1]

Version: 0.07 Page 8/171
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Ce document est subdivisé comme suit :

Installation

Configurer YapsON

Configurer GlassFish

Configurer NetBeans

Importer le projet BarkBank

Importer le projet PetEx

Importer le projet Yaps — coté serveur

Importer le projet Yaps — coté client

Conclusion

Installation de NetBeans et des fichiers
nécessaires au processus d’importation de
I’application Yaps Pet Store.

Décris la configuration a apporter aux
fichiers livrés avec I’application initiale
YapsON.

La configuration de GlassFish nécessaire
avant de pouvoir déployer les différents
projets.

La configuration de NetBeans avant
d’accueillir les projets a déployer.

L’importation et le déploiement du projet
BarkBank.

L’importation et le déploiement du projet
PetEx.

L’importation et le déploiement de la
partie serveur du projet Yaps.

L’importation et le déploiement de la
partie cliente du projet Yaps.

La conclusion de ce document.

Version:

0.07
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2 Conventions
2.1 Langue

Dans ce document, les copies d’écrans des logiciels utilisés (Microsoft Windows, NetBeans,
etc.) sont en anglais. IIs peuvent donc différer de votre environnement.

2.2 Mots clés

Le tableau suivant fournit 1’ensemble des mots clés utilisés dans le document :

Livre de référence | Par “Livre de référence”, nous entendons le livre sur Java EES
d’Antonio Goncalves (voir [R1]).

Yaps Identifie I’application originale Yaps Pet Store fournie par I’auteur du
livre de référence.

YapsON Identifie I’application Yaps importée sous NetBeans (Yaps Pet Store on
NetBeans).

2.3 Répertoires

{netbeans home} | Répertoire d’installation de NetBeans.

{glassfish_ home} | Répertoire d’installation de GlassFish v2.

{yaps_home} Répertoire hébergeant I’application originale Yaps Pet Store.

{yaps_on_home} Répertoire de I’application Yaps créé sous NetBeans.

2.4 Commandes

Les commandes sont représentées de la maniere suivante :

C:\> echo “This is a command”

Cette commande affiche a 1’écran la phrase suivante: “This is a command ».

Version: 0.07 Page 10/171
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2.5 Messages

Dans le document, des messages peuvent apparaitre pour alerter ou informer le lecteur.

Titre du message (optionnel)

Permets d’alerter le lecteur.

¢

Titre du message (optionnel)

Permets d’informer le lecteur.

Version: 0.07 Page 11/171
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3 Installation

3.1 Prérequis
Ce document a été congu avec la configuration logicielle suivante:
* Microsoft Windows Vista Service Pack 1 ou supérieur
* Sun Java Development Kit (JDK) 1.6 Update 7 ou supérieur
* Ant 1.7.0 ou supérieur
* NetBeans 6.5 install¢ avec le Bundle « All »
* Les fichiers de Yaps
* Les fichiers de YapsON

Le chapitre 3 du livre de référence décrit comment installer le JDK et Ant.

" 4
NetBeans 6.7.1 et Mac OS X

Ce tutoriel a également été appliqué sur une version de NetBeans 6.7.1 installée sous Mac
OS X Snow Leopard.

3.2 NetBeans

NetBeans” 6.5 est I'IDE (Integrated Development Environment) Open Source de Sun congu
pour concevoir, déployer et tester des applications développées sous différents langages (Java,
PHP, Ruby, C/C++, etc.).

Tout comme Eclipse, NetBeans utilise la notion de plug-ins pour enrichir son environnement
de développement.

En ce qui concerne JEES, NetBeans fournit un environnement riche et complet pour
concevoir des applications (visuelles ou non) et les déployer au sein de serveurs tels que
GlassFish ou Tomcat qui font partie intégrante du kit d’installation.

NetBeans est disponible sous différents bundles. Chacun couvrant un ensemble de
fonctionnalités.

Ce document a été congu sur base du bundle « All » de NetBeans. Mais vous pouvez vous
contenter du bundle « Java » et récupérer plus tard les plug-ins qui vous intéressent (par
exemple le stack SOA).

2 Voir [R4] pour I’historique de NetBeans
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" 4
Stack SOA et NetBeans 6.7.x

Le stack SOA n'est plus livré en standard sous NetBeans 6.7.x.

Les plugins SOA peuvent étre installés en utilisant I'option Tools>Plugins.

Mais pour ceux qui souhaitent travailler avec les outils SOA de Sun, il est fortement
recommandé¢ d'utiliser I'environnement GlassFish ESB qui intégre une version de NetBeans:

https://open-esb.dev.java.net/Downloads.html

Dans ce cas précis, la version de I'IDE NetBeans intégrée a GlassFish ESB sera stirement
antérieure a celle accessible sur le site de NetBeans (http://www.netbeans.org).

3.2.1 Récupérer NetBeans
NetBeans 6.5 peut étre téléchargé gratuitement a partir du site de Sun a I’adresse suivante:

http://www.netbeans.org

La page affiche la derniere version en date de NetBeans.

Home | Features | Plugins | Docs & Support Ci ity I Partners

%0 NetBeansIDE - 5 st Retesses) &
The only IDE you need! Runs on Windows, Linux, Mac OS X and Solaris. -t

NetBeans IDE is open-source and free.

© Learn More about NetBeans IDE ( Download NetBeans IDE) Introduction to NetBeans 6.5
Screencast

NetBeans Supported Technologies
Ajax | C/C++ | Databases | Debugger | Desktop | Editor | Groovy | GUI Builder
| Java EE | JavaFX | Java ME | Java SE | JavaScript | Mobile | PHP |
Profiler | Python | Refactor | REST | Rich Client Platform | Ruby | soa | soae |
~ umL | Web | wspL
S

Featured News
NetBeans Podcast Episode 48 - 6.5 is Here!

 See All News

Figure 3-1: Version de NetBeans

Cliquez sur le bouton “Download NetBeans IDE” pour continuer.
La page de téléchargement permet de définir les propriétés du kit NetBeans :
* Langue de travail

e Plateforme
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Language: |Eng|ish v | Platform: IWindows 2000/XP/Vista vl
Note: Th

4]
1]

UML Pack is available on the Update Center.

Figure 3-2: Langue de travail et plateforme

Ensuite, il vous reste a sélectionner le type de bundle :

tBeans IDE Download Bundles

Supported technologies * Java SE Java Ruby C/C++ PHP All
) Java SE L] L] [
%) Java Web and EE [ ] °
%) Java ME [ L[]
) Ruby L[] L[]
L C/C++ ] °
L PHP L] [ ]
L SOA [ ]
Bundled servers

L) GlassFish V2 UR2 L] o
L) GlassFish v3 Prelude [ ] ° °
%) Apache Tomcat 6.0.18 [ ] ]

\ Download :]I (: Download :]l I]: Download :J [: Download :] I,': Download :] I_': Download
Free, 37 MB Free, 212 MB Free, 58 MB Free, 23 MB Free, 24 MB Free, 250 MB

Figure 3-3: Type de bundle
Ce document est congu a partir du bundle “All”.

Cliquez sur le bouton “Download” pour télécharger NetBeans.

" 4
Site de NetBeans

Le site de NetBeans regorge d’information utile qui facilitera votre prise en main de cet
IDE.

Vous trouverez notamment bon nombre de tutoriaux estampillés avec la version de I'IDE
qui est supportée.

3.2.2 Installer NetBeans
Vous allez passer en revue les différentes étapes requises pour installer NetBeans.

Commencez par exécuter le fichier “netbeans-6.5-ml-windows.exe*.

3.2.2.1 Page d’accueil

La page d’accueil permet d’emblée de définir la liste des composants a installer :
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I NetBeans IDE Installer

& NetBeansIpE- -

Welcome to the NetBeans IDE 6.5 Installer

The installer will install the NetBeans IDE with the following packs and runtimes.
Click Customize to select the packs and runtimes to install.

Base IDE

Java SE

Common Web Components
Java Web and EE

Java ME

Ruby

C/C++

PHP

SOA

Runtimes
GlassFish V2 UR2
GlassFish v3 Prelude
Open ESB v2

Installation Size: 643.3 MB

i Next> | [ Cancel

Figure 3-4: Page d'accueil

Le seul composant optionnel est le serveur d’applications « Tomcat version 6».

Si vous souhaitez modifier la liste des composants a installer, cliquez sur le bouton

« Customize... » :
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|~ e — N
(%] Customize Installatio;— w

Select packs and runtimes to install from the list below.

Base IDE Description

Java SE Tools for creating Java web and

enterprise applications compatible
Common Web Components with J2EE 1.4, and Java EE 5

Java Web and EE specifications. Incdudes support for
Java ME servlets, JSPs, tag libraries, Spring,
Rub Struts, Java Persistence API,

uby Enterprise Java Beans, JAX-WS and
C/C++ RESTful web services, and Java
PHP Server Faces, the Groovy language

and the Grails framework. Provides

S‘_jA visual drag-and-drop application
Runtimes development environment.

GlassFish V2 UR2
GlassFish v3 Prelude
Apache Tomcat 6.0.18
Open ESB v2

| Installation size: 659.7 MB

L Lo ][ concel ]

Figure 3-5: Paramétrer (Customize) l'installation

Dans I’écran ci-dessus, on remarque que 1’ensemble des composants a été sélectionné.
Dans le contexte de I’application YapsON, veillez a sélectionner les composants suivants :
* Base IDE
e JavaSE
*  Common Web Components
* Java Web and EE
* (lassFish V2 R2

Cliquez sur « OK » pour valider votre configuration.

Ensuite, cliquez sur « Next » pour continuer.

3.2.2.2 License Agreement
Cette étape présente la licence Open Source utilisée par NetBeans :

Version: 0.07 Page 16/171
Published on: 01-Oct-2009



NORATER
eessecseccnesncnesi The way to your IT projects

YAPS Pet Store sous NetBeans

. NetBeans IDE Installer l:llﬂu

License Agreement

Please read the following license agreement carefully. @ Nmnnallslnf 65

NETBEANS IDE 6.5 ("Product”)

Please review the complete list of open-source licenses
governing software incuded in the Product. They can be
found in the THIRDPARTYLICENSE. txt file. Sun elects to use
only the GNU Lesser General Public License version 2.1
(LGPL)/GNU General Public License version 2 (GPL) for any
software where a choice of LGPL/GPL license versions are
made available with the language indicating that
LGPLv2.1/GPLv2 or any later version may be used, or where a
choice of which version of the LGPL/GPL is applied is
unspecified.

Please review the list of libraries and licenses provided
for use. This license file contains four distinct licenses.

Unless specified below, the use of NetBeans IDE 6.5 and
components from the GlassFish runtime are governed by the
terms of either the GNU General Public License Version 2

{ accept the terms in the license agreement

[(<Bac | [(Next> ] [ Concsl ]

Figure 3-6: Licence de NetBeans

Acceptez les termes de la licence et cliquez sur “Next” pour continuer.

3.2.2.3 Répertoires d’installation

Cette étape permet de définir les répertoires d’installation de NetBeans et de localiser le JDK
préinstallé dans votre environnement :
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N—etABeans IDE Installer

NetBeans IDE 6.5 Installation

Choose the installation folder and JDK™, @ NmnaaMI“E 65

Install the NetBeans IDE to:

:C:\Drogram Files\NetBeans 6.5

JDK™ for the NetBeans IDE:
VC:\Drogram Files\Java\jdk1.6.0_10

[<Bad< ][ Next > ][Cancel]

Figure 3-7: Répertoires d'installation

Cliquez sur « Next » pour continuer.

3.2.2.4 Propriétés de GlassFish v2

Cette étape vous permet de définir les propriétés du serveur GlassFish v2 sur lequel sera
déploy¢ YapsON :
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/| GlassFish V2 UR2 Installation

. : NetBeans IDE Installer (o e e S

Choose the installation folder and server properties. @ NmnaaMInE 65

Install GlassFish to:

JDK™ for GlassFish application server:
C:\Program Files\Java\jdk1.6.0_10

C:\Program Files\glassfish-v2ur2

Admin Username: |admin

Admin Password: eeessssese (default: adminadmin)

Retype Password: eeeeeessse

HTTP Port: 8080

HTTPS Port: 8181

Admin Port: 4348

[ < Back ][ Next > ] [ Cancel

Figure 3-8: Paramétres de GlassFish V2

Nous avons gard¢ les paramétres par défaut a savoir :

GlassFish

Le dossier ou sera installé GlassFish v2.

JDK

Le dossier ou a été installé le JDK.

Admin Username

Le nom qui sera utilis¢ pour administrer GlassFish.

Le défaut est: admin

Admin Password

Le mot de passé de I’administrateur de GlassFish.

Le défaut est: adminadmin

Ports

Les numéros de port.

Cliquez sur « Next » pour continuer.

3.2.2.5 GlassFish v3

La version 3 de GlassFish est livrée a titre d’évaluation (Prelude version).
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L’application YapsON n’utilise pas GlassFish v3 :

' i) NetBeans IDE Installer EIM

GlassFish v3 Prelude Installation

Choose the installation folder. @ Nﬂmﬂaﬂsmf 65

Install GlassFish to:

C:\Program Files\glassfish-v3-prelude

[<Bad< ][Next> ][Cancel]

Figure 3-9: Répertoire de GlassFish v3

Vous pouvez garder le défaut et cliquer sur « Next » pour continuer.

3.2.2.6 Apache Tomcat

Cette étape apparait uniquement si vous avez sélectionné le package optionnel de Tomcat.

Dans ce cas, I’écran suivant vous demande de choisir le répertoire d’installation de Tomcat v6
ou d’accepter le défaut :
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~ NetBeans IDE Installer Ll_lgcl =k

Apache Tomcat 6.0.18 Installation

Choose destination folder. @ Nﬂmﬂallsmf 65

Install Apache Tomcat to:
vC:\Program Files\Apache Software Foundation\Apache Tomcat 6.0. 18

[<Bad<][Next> J[Canoel]

Figure 3-10: Répertoire de Tomcat v6

Cliquez sur « Next » pour continuer.

3.2.2.7 Résumé

La page suivante présente un résumé du paramétrage :
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~ NetBeans IDE Installer Ll_lgcl =k

Summary

Click Install to start the installation. @ Nﬂmﬂallsmf 65

NetBeans IDE Installation Folder:
C:\Program Files\NetBeans 6.5

GlassFish V2 UR 2 Installation Folder:
C:\Program Files\glassfish-v2ur2

GlassFish v3 Prelude Installation Folder:
C:\Program Files\glassfish-v3-prelude

Apache Tomcat 6.0. 18 Installation Folder:
C:\Program Files\Apache Software Foundation\Apache Tomcat 6.0. 18

Open ESB v2 will be installed to the GlassFish folder.

Total Installation Size:
659.7MB

| <Back || Instal | [ Cancel |

Figure 3-11: Résumé d'installation

Cliquez sur « Install » pour démarrer le processus d’installation.

3.2.2.8 Finish

A la fin de I’installation, la derniére étape vous demande d’enregistrer NetBeans et
GlassFish :
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NetBeans IDE Installer E‘M

Setup Complete

Click Finish to finish the NetBeans IDE setup. @ N“B‘MI"E 65

Installation completed successfully.

Contribute to the NetBeans project by providing anonymous usage data

@ If you agree to participate, the IDE will keep track of the high-evel features you use
@ The collected anonymous data will be submitted to a usage statistics database at netbeans.org server

The usage statistics will help the development team to better understand user requirements and prioritize
improvements in future releases. There is no absolutely no way to reverse-engineer the collected data to find
specific details concerning your projects. See more information.

Register the NetBeans IDE and GlassFish after finishing the installation

Registration gives you the following benefits:

@ Spedal offers on Sun developer products, services and training
@ Ability to track and manage your registered products on the SunConnection Inventory site

Registration is FREE.

Figure 3-12: Enregistrer NetBeans et GlassFish

Cliquez sur « Finish » pour terminer le processus d’installation.

3.2.3 Démarrer NetBeans
Démarrez NetBeans sous le lien:

Start— All Programs — NetBeans — NetBeans IDE 6.5

NetBeans offre un processus automatique qui lui permet de vérifier la présence de mises a
jour.

Ce processus est enclenché a chaque démarrage de NetBeans :

Checking for updates... | wm |

Figure 3-13: Vérification des mises a jour
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Un message dans la barre de statut vous informe de la présence des mises a jour :

%8

30 updates found.

Click here to make your IDE up to date.
R

S

Figure 3-14: Mises a jour détectées

Pour visualiser la liste des mises a jour et les appliquer, cliquez sur 1’icone de la barre de
statut.

Il est bien entendu recommandé d’appliquer ces mises a jour.

¢

Mises a jour manuelles

NetBeans permet ¢galement de vérifier manuellement la présence de mises a jour au travers
du menu « Help— Check For Updates ».

3.2.4 Localisation
Par défaut, NetBeans utilise la localisation courante pour afficher ses boites de dialogues.

Vous pouvez forcer une localisation spécifique en modifiant le fichier « netbeans.conf » de
NetBeans qui se trouve a I’emplacement suivant :

{netbeans home}\etc\netbeans.conf

Dans ce fichier, modifiez I’entrée “netbeans_default_options” pour y ajouter I’option :

-—locale <code langue>

Par exemple, pour forcer le code langue en anglais :

--locale EN

Ci-dessous, un extrait du fichier de configuration montre le code langue fixé¢ a EN :

# Options used by NetBeans launcher by default, can be overridden by
explicit

# command line switches:

netbeans default options="-J-
Dorg.netbeans.modules.tomcat.autoregister.token=1227909276055 -J-
Version: 0.07 Page 24/171
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Dorg.netbeans.modules.tomcat.autoregister.catalinaHome=\"C:\Program
Files\Apache Software Foundation\Apache Tomcat 6.0.18\" -J-
Dorg.glassfish.v3.installRoot=\"C:\Program Files\glassfish-v3-prelude\" -J-
Dcom.sun.aas.installRoot=\"C:\Program Files\glassfish-v2ur2\" -J-client -J-
Xverify:none -J-Xss2m -J-Xms32m —-J-XX:PermSize=32m -J-XX:MaxPermSize=200m -
J-Dapple.laf.useScreenMenuBar=true -J-Dsun.java2d.noddraw=true --locale EN"

¢

Positionnez le code langue

Une autre méthode consiste a modifier les propriétés de démarrage de NetBeans pour y
ajouter le code langue :

Q NetBeans IDE 6.5 Properties [ = ]

[ General l Shortcut lCompaﬁbiIity l Security l De(ails‘

@ NetBeans IDE 6.5

Target type: Application

Target location: bin

Target: iles\NetBeans 6.5\bin\netbeans exe" -ocale EN

Start in: "C:\Program Files\NetBeans 6.5"

Shortcut key:  None

Run: [Nonnal window M ]

Comment: The only IDE you need

[ Open File Location ] [ Change Icon... ] [ Advanced... ]
0K [ Cancel | [ Aepy |

Figure 3-15: Code langue

3.3 Variables d'environnement
Il sera quelquefois nécessaire d'exécuter des instructions via la ligne de commande.

Pour ce faire, les variables d'environnement suivantes doivent étre définies dans votre
systeme:

« GLASSFISH HOME
« ANT HOME
« JAVA HOME

La variable d'environnement PATH doit également étre adaptée pour localiser les logiciels
requis.
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Ci-dessous, nous donnons un exemple de définition de variables d’environnement sous
MS-Windows:

C:\> set ANT HOME=C:\Tools\Ant\apache-ant-1.7.1

C:\> set PATH=%ANT HOME%\bin;$%PATH%

C:\> set GLASSFISH HOME=C:\Program Files\glassfish-v2ur2
C:\> set PATH=%GLASSFISH_HOME%\bin;%PATH%

C:\> set JAVA HOME=C:\Program Files\Java\jdkl.6.0_ 10

C:\> set PATH=%JAVA HOME%\bin;$PATH$%

Ces variables d'environnement peuvent ¢galement €tre définies dans les propriétés systéme de
MS-Windows.

3.4 Récupérer ’application Yaps
Récupérez I’application Yaps que sera importée sous NetBeans.

L’application Yaps se trouve a I’adresse suivante :
http://www.antoniogoncalves.org/xwiki/bin/view/Book/JavaEESFr

Dans cette page, reportez-vous a la section relative au téléchargement du code source :

Teléchargez et installez ['application

Figure 3-16: Télécharger Yaps

Ce document est basé sur une version 1.6 du JDK. Veillez a télécharger le code source de
l'application Yaps correspondant au JDK 1.6.

Ensuite, vous devez extraire le fichier d’archives dans un répertoire qui sera référencé dans la
suite du document sous le nom {yaps_home}.
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Les répertoires et les documents suivants sont extraits du fichier d’archives :

”
Name

. BarkBank
. PetEx
. Yaps
admin.xml
build.xml
| derby.log
| passwordfile
| readme.txt

Date modified Type Size
09/10/2008 10:50 File Folder

09/10/2008 10:50 File Folder

09/10/2008 10:50 File Folder

01/10/2007 14:57 XML Document 21 KB
01/10/2007 14:57 XML Document 31KB
09/10/2008 11:32 Text Document 1KB
01/10/2007 14:57 File 1KB
01/10/2007 14:57 Text Document 18 KB

Figure 3-17: Structure de I'archive Yaps

Le livre de référence détaille I’ensemble des répertoires.

3.5 Récupérer ’application YapsON

L’application YapsON est disponible sous deux archives différentes:

YapsON-initial.zip

Ce fichier contient la version minimale de 1’application YapsON
utilisée comme point de départ au processus de portage décrit
dans ce document.

YapsON-complete.zip

Ce fichier contient la version compléte de 1’application YapsON
telle qu’obtenue apres la phase de portage décrite dans ce
document.

Ce document décrit les étapes de portage a appliquer sur la version minimale de ’application

YapsON.

La version minimale est composée des fichiers suivants :

admin.xml Ce fichier Ant provient du projet Yaps Pet Store et contient un
ensemble de taches pour configurer et gérer GlassFish et Derby.
passwordfile Contiens le mot de passe (en clair) de I'administrateur GlassFish.

Ce fichier est requis par le processus Ant durant la préparation du
domaine "Petstore".

setenv-yaps.cmd

Fichier de commande définissant les variables d’environnement
JAVA HOME, ANT HOME, GLASSFISH HOME.

setenv-yaps.sh

Fichier de commande (Linux, Mac OSX) définissant les variables
d’environnement JAVA HOME, ANT HOME,
GLASSFISH HOME.

yapson.xml

Fichier de script Ant permettant le transfert des projets Yaps vers
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I’arborescence de NetBeans.
yapson.properties Fichier de propriétés utilisé par le script Ant « yapson.xml ».
yaps-data.xml Fichier de script Ant utilisé pour charger la base de données avec
les données de test.

Les fichiers de I’application YapsON sont disponibles a I’adresse suivante :

http://www.noratek.net/2008/12/08/yaps-sous-netbeans-65/

Vous devez récupérer et extraire le fichier d’archives YapsON-initial.zip dans un répertoire
qui sera référencé dans la suite du document sous le nom {yaps_on_home} :

Name

»o.

admin.xml
passwordfile
setenv-yaps.cmd
setenv-yaps.sh
yaps-data.xml
yapson.properties
yapson.xml

Figure 3-18: Structure de I'archive YapsON
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4 Configurer YapsON

Avant d’entamer le processus de configuration, vous allez configurer les fichiers de
commande livrés avec le fichier d’archives de 1’application YapsON.

4.1 Variables d’environnement

Editez le fichier « setenv-yaps.cmd » (ou "setenv-yaps.sh" si vous étes sus Linux ou Mac
0OSX) et modifiez les variables d’environnements suivantes pour y placer les répertoires
d’installation adéquats :

YAPS HOME Répertoire d’installation de 1’application Yaps (voir section 3.4).

YAPSON_HOME Répertoire d’installation de 1’application YapsON (voir section
3.5).

GLASSFISH_HOME | Répertoire d’installation de GlassFish v2 (voir section 3.2.2.4).

ANT_HOME Répertoire d’installation d’Ant (voir section 3.1).

JAVA _HOME Répertoire d’installation du JDK (voir section 3.1).

4.2 Scripts Ant

Editez le fichier « yapson.properties » et modifiez les propriétés suivantes :

yaps.folder Répertoire d’installation de 1’application Yaps (voir section 3.4).
yapson.folder Répertoire d’installation de 1’application YapsON (voir section
3.5).

Il y a également lieu d’éditer le fichier « yaps-data.xml » afin de modifier la propriété
suivante :

glassfish.home Répertoire d’installation de GlassFish v2 (voir section 3.2.2.4).
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S Configurer GlassFish

La configuration du serveur d’applications GlassFish est similaire a celle exposée dans le livre
de référence et résumée dans le fichier « readme.txt » livré avec le fichier d'archives de Yaps.

Afin de rendre ce document autonome, nous allons rappeler les commandes nécessaires pour
configurer GlassFish.

Pour cela, vous allez utiliser les taches Ant a partir de la ligne de commande.

Problémes avec Ant et le copié/collé

Vous pouvez rencontrer des problémes si vous copiez/collez d’un document (MS-Word,
PDF, etc.) des commandes Ant vers la ligne de commande.

Ci-dessous, nous illustrons un probléme qui peut apparaitre :

C:\Projects\Yaps>ant —f admin.xml start-domain

Buildfile: build.xml

BUILD FAILED

Target "Gf" does not exist in the project "Petstore".

Total time: O seconds

Il semblerait que dans certains cas, des caracteéres spéciaux accompagnent la commande qui
vient d’étre collée. Ant détecte ces caracteres spéciaux et tente de trouver la cible
correspondante. Qui n’existe bien évidemment pas.

Pour éviter ce probléme, taper les commandes ou configurer votre environnement pour
définir un codepage adéquat.

5.1 Positionner les variables d'environnement

Avant tout, vous devez positionner les variables d’environnement nécessaires pour
I’exécution des tiches Ant de configuration.

Rendez-vous dans le répertoire de I’application YapsON et exécutez le fichier de commande
« setenv-yaps.cmd » :

C:> cd {yapson home}

{yapson_home}> setenv-yaps.cmd

Version: 0.07 Page 30/171
Published on: 01-Oct-2009



NORBATER
eessesseccnecncnesis The way to your IT projects

YAPS Pet Store sous NetBeans

¢

Variables d'environnement sous Linux ou Mac OSX

En régle générale, si vous étes sous Linux ou Mac OSX, vous devrez utiliser le script
"setenv-yaps.sh" pour positionner les variables d'environnement.

5.2 Créer le domaine « petstore »

Sous GlassFish, vous allez créer le domaine « petstore » dans lequel seront déployés les
projets de 1’application YapsON.

Les propriétés du domaine « petstore » sont les suivantes :

Name petstore

http port number 8080

Admin port number | 8282

Admin username admin
Admin password adminpwd
Master password masterpwd

Exécutez la commande « asadmin » suivante afin de créer le domaine « petstore »:

{yapson_home}> asadmin create-domain --adminport 8282 --user admin --savemasterpassword=true -
-instanceport 8080 petstore

La procédure de création du domaine « petstore » vous demande de définir les mots de passe
« admin » et « master » :

Please enter the admin password>
Please enter the admin password again>

Please enter the master password [Enter to accept the default]:>
Please enter the master password again [Enter to accept the default]:>

Pour rester conforme au livre de référence, vous allez introduire les mots de passe suivants:

« adminpwd pour le « admin » password

« masterpwd pour le « master » password

Pour terminer, la procédure vous informe des numéros de ports assignés au domaine
« petstore » :
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port
port
port
port
port
port

Using port 8282 for Admin.
Using port 8080 for HTTP Instance.
Using default
Using default
Using default
Using default
Using default
Using default

7676 for
3700 for
8181 for
3820 for
3920 for
8686 for

Security Store uses: JKS

Domain petstore created.

JMS.
IIOP.

HTTP_SSL.
IIOP_SSL.
IIOP_MUTUALAUTH.
JMX ADMIN.

Domain being created with profile:developer, as specified by variable AS ADMIN PROFILE in
configuration file.

A ce stade, le domaine “petstore” est physiquement créé sous le répertoire « domains » de

GlassFish :

06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008
06/11/2008

23:
23:
23:
23:
23:
23:
23:
23:
23:
23:
23:
23:
23:
23:
23:
23:

59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59 <DIR>
59

59 <DIR>
1 File(s)

500

{yapson_home}> dir {glassfish home}\domains\petstore

addons
applications
autodeploy
bin

config

docroot
generated

img
java-web-start
jbi

lib

logs
master-password
session-store

500 bytes

15 Dir(s) 149.829.881.856 bytes free

¢

Suppression d’un domaine sous GlassFish

Lors des phases de tests, on peut étre amené a devoir supprimer un domaine.

Le script Ant « admin.xml » propose le target « delete-domain » pour supprimer un domaine
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de GlassFish.

On peut également directement utiliser I’interface d’administration de GlassFish comme
illustré ci-dessous.

Tout d’abord, veuillez démarrer I’interface d’administration via la commande « asadmin » :

{yapson_home}> asadmin

Use "exit" to exit and "help" for online help.

asadmin>

A D’invite de I’interface d’administration, vous pouvez supprimer le domaine en utilisant la
commande « delete-domain »:

delete-domain --domaindir {glassfish home}\domains petstore

Domain petstore deleted.

Cette commande nécessite d’identifier :
* le répertoire « domains » de GlassFish

* le nom du domaine a supprimer (dans notre exemple, il s’agit du domaine « petstore »)

Pour sortir de I’interface « asadmin », il suffit d’introduire la commande « exit ».
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5.3 Démarrer le domaine « petstore »

Le domaine « petstore » que vous venez de créer doit étre démarré afin de poursuivre la
configuration du serveur GlassFish.

L’application YapsON fournit le fichier « admin.xml » contenant des taches qui permettent de
démarrer et stopper le domaine.

Placez-vous dans le répertoire de 1’application YapsON:

C:\> cd {yapson_home}

{yapson_home}>

Exécuter la tache « start-domain » pour démarrer le domaine « petstore » :

{yapson_home}> ant -f admin.xml start-domain

Les traces doivent indiquer que le domaine « petstore » est correctement démarré :

[exec] Domain [petstore] is running [Sun Java System Application Server 9.1 02 (build b04-
fcs)] with its configuration and logs at: [C:\Program Files\glassfish-v2ur2\domains].

A ce stade, il est possible d’accéder a la console d’administration du domaine « petstore » au
travers du lien suivant :

http://localhost:8282

L’écran de login suivant apparait :

Sun Java ™ System Application Server
Admin Console

User Name: admin

Password:  eeesecse

Login

Figure 5-1: Ecran de login

Sur base de notre configuration (voir section 5.2), les informations suivantes doivent étre
introduites :
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e User Name : admin

e Password :

La console d’administration apparait a I’écran :

5.4 Localisation de GlassFish

adminpwd

Home

User: admin | Domain: petstore  Server: localhost

Sun Java™ System Application Server Admin Console

B Tasks
oS Common Tasks

3 Reostton
D Application Server
v [ Appicatons

Enterprise Appiications Registration and Support
Web Applcations —

@ e Subscriptions

B

Update Center

Application Client Modules
@ Web Sevices
B
Service Assembies
» ) components

Getting Started Guide

No New Components Available

Deployment

Deploy Enterprise Application (.ear)

> @ sha
Custom MBeans Deploy Web Application (war)
> [§§ Resources Deploy Custom MBean
> (g Configuration Deploy Java Business Integration (JBI) Service Assembly

Clustering

Add Cluster Support

SN

Outside the U.S., please purchase WITB-SAS-1600 from your Sun country training Web ste.

New GlassFish Admin Training

Leamn how to install, configure & administer
GlassFish with downloadable labs! » Get It

® Leam S

® Join the Project GlassFish

Other Tasks
Search Log Files
Create New JDBC Connection Pool

View Web Senvices

Monitoring

View Monitoring Data

documentation
Quick Start Guide
Administration Guide
Developers Guide
Application Deployment Guide

Deployment Planning Guide

® Stay current with GlassFish news at The Aquarium or learn about GlassFish deployments.

- ® Getcommunity support, Developer Expert Assistance or production support.

® Checkthe documentation

Figure 5-2: Console d'administration

Par défaut, la console d’administration de GlassFish utilise la localisation définie sur le
systeme.

Nous allons décrire comment changer la localisation sous GlassFish:

Ouvrez la console d’administration accessible a 1’adresse http://localhost:8282.

Connectez-vous avec votre compte administrateur.

Sélectionnez le noeud Application Server.

Sélectionnez I’onglet Advanced et ensuite Domain Attributes.

Changez la valeur de I’entrée Locale pour y définir le code langue que vous souhaitez

utiliser.

Sauvez vos modifications.

La modification du code langue nécessite un redémarrage du serveur GlassFish.

La figure suivante illustre 1’application de I’anglais (en-UK) comme langue de travail :
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Application Server

JVM o 8 8 o Administrator
General Settings Logging Monitor Diagnostics PRE SO Advanced 1
Applications Configuration Domain Attributes

Domain Attributes

Application Root | ¢{com sun.aas.instanceRoot}/applications
Directory from which applications are deployed

Log Root ${com sun.aas.instanceRoot}/logs
Location of the server instance's log files

Locale en_UK

Overrides OS locale setting

Figure 5-3: Localisation sous GlassFish
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5.5 Créer les ressources Database

Les données de I’application Yaps sont maintenues dans une base de données de type Sun
Java DB.

[
Sun Java DB et Apache Derby

Il n’existe pas de différence entre Sun Java DB et Apache Derby.
Apache Derby est packagé par Sun sous le nom Java DB.

Cette section décrit le processus de création de I’ensemble des ressources requises pour
accéder et manipuler la base de données « petstoreDB ».

[
Base de données sous MySQL

La base de données de 1’application Yaps peut étre définie sous MySQL.

L’auteur du livre de référence décrit comment modifier la configuration pour supporter
MySQL :

http://www.antoniogoncalves.org/xwiki/bin/view/Book/JavaEESInstalIMySQLFr

Commencez par vous placer dans le répertoire de I’application YAPS:

C:\> cd {yapson_home}

{yapson_home}>

5.5.1 Pool de connexions JDBC

Exécutez la tache « create-connection-pool » pour créer le pool de connexions
« petstorePool » :

{yapson_home}> ant -f admin.xml create-connection-pool

[exec] Command create-jdbc-connection-pool executed successfully.

En recherchant le statut « BUILD SUCCESSFUL », on s’assure que I’exécution de la tache
s’est correctement déroulée.
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La tache « list-connexion-pool » permet de vérifier que le pool de connexion JDBC a été
correctement cré¢ :

{yapson_home}> ant -f admin.xml list-connection-pool

[exec] _ CallFlowPool

[exec] _ TimerPool

[exec] DerbyPool

W

[exec] Command list-jdbc-connection-pools executed successfully.

[exec]

[exec] C:\Projects\YapsON>endlocal

BUILD SUCCESSFUL

Une autre maniére consiste a se rendre sur la console d’administration de GlassFish.
Le pool de connexions JDBC se trouve a I’emplacement suivant :

Resources — JDBC — Connection Pools — petstorePool

E Common Tasks

8 Registration
Application Server
i» lﬁ Applications
i Web Services
> & B
Custom MBeans
A Lﬁ) Resources
vE JDBC
> JDBC Resources
> Connection Pools

E:El __CallFlowPool
19 __TimerPool
Lg DerbyPool
= petstorePool

> ;j JMS Resources

[ JavaMail Sessions
> (7] JNDI
> 3 Connectors
> B Configuration

Figure 5-4: Pool de connexions JDBC
N’hésitez pas a inspecter les propriétés du pool de connexion « petstorePool ».

Les propriétés définies dans ’onglet « Additional Properties » seront utilisées plus tard lors
de la création de la base de données :
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Resources = JDBC > Connection Pools > petstorePool

General Advanced Additional Properties

Edit Connection Pool Properties
Modify properties of existing JDBC connection Pool
@ @ Delete Properties

‘ ’ Name 4 { Value 14
[ user dbuser
[] | connectionAttributes create=true
[C] | | portNumber 1527
[C] ' |databaseName petstoreDB
[C] ' |Password dbpwd
[ [serverName localhost

Figure 5-5: Propriétés du pool de connexion

5.5.2 Démarrer le serveur Derby

Avant de poursuivre le processus, il est nécessaire de démarrer le serveur de base de données
Derby.

Exécutez la tache « start-db » pour démarrer Derby :

{yapson_home}> ant -f admin.xml start-db

[exec] Starting database in the background.

[exec] Lag = ec—tT—C T P TUg T g+assfish-v2ur2/javadb\derby.log.

exec] Command start-database executed successfully.

5.5.3 Créer la base de données
La base de données est créée en exécutant un « ping » vers le pool de connexion.

Exécutez la tache « ping-connection-pool » pour créer la base de données « petstoreDB » :

{yapson_home}> ant -f admin.xml ping-connection-pool

[exec] Command ping-connection-pool executed successfully.

La base de données « petstoreDB » est maintenant créée sous le répertoire « javadb » de
GlassFish :

{glassfish_home}\javadb\petstoreDB
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4 |, glassfish-v2ur2
. addons
. bin
. config
. docs
. domains
. imq
4 |, javadb
. bin
. demo
. EURUTIP
. frameworks
. iepseDB
. lib
4 | petstoreDB
, log
) seg0
, tmp

Figure 5-6: Base de données petstoreDB

5.5.4 Créer la source de données
La source de données (data source) permet a I’application d’accéder a la base de données.

Exécutez la tache « create-datasource » pour créer la source de données « petstoreDS » :

{yapson_home}> ant -f admin.xml create-datasource

[exec] Command create-jdbc-resource executed successfully.
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Utilisez la tache « list-datasource » pour vérifier que la data source a bien été créée :

[exec] jdbc/_ TimerPool
[exec] jdbc/_CallFlowPool

[exec] didbc defanlt

jdbc/petstoreDS

{yapson_home}> ant -f admin.xml list-datasource

c-resources executed successfully.

Une autre maniére consiste a se rendre sur la console d’administration de GlassFish.

Le pool de connexions JDBC se trouve a I’emplacement suivant :
Resources— JDBC— JDBC Resources— jdbc/petstoreDS

Common Tasks

_‘ Registration
Application Server
> Applications
Q Web Services
> 5 Bl
Custom MBeans
v @ Resources
v |£9 JDBC
> JDBC Resources
@ jdbc/__TimerPool
‘g jdbc/__CallFlowPool
l;_’:j jdbc/__default
|| ldbcipetstoreDS
> Connection Pools

JMS Resources

[ JavaMail Sessions

> [ JNDI
L] Connectors

> \ﬁ Configuration

Figure 5-7: JDBC Resources
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5.6 Créer les ressources JMS

Vous allez maintenant créer les ressources JMS que sont la file d'attente (JMS topic) et la
fabrique de connexion (Connection Factory).

5.6.1 Créer la fabrique de connexion

Exécutez la tiche « create-jms-connection-factory » pour créer la fabrique de connexion
JMS (Connection Factory) « jms/petstoreConnectionFactory » :

{yapson_home}> ant -f admin.xml create-jms-connection-factory

@d create-jms-resource executed successfully.

5.6.2 Créer la file d’attente

Exécutez la tiche « create-jms-topic » pour créer la file d'attente (JMS topic)
« jms/topic/order »:

{yapson_home}> ant -f admin.xml create-jms-topic

@d create-jms-resource executed successfully.

5.6.3 Vérification

Utilisez la tache « list-jms-resources » pour énumérer les ressources JMS définies sous
GlassFish :

{yapson_home}> ant -f admin.xml list-jms-resources

</—[;E jms/topic/order
~—~——exec] jms/petstoreConnectionFactory

[exec] Command list-jms-resources executed successfully.

BUILD SUCCESSFUL

Vous devez vous assurer que la file d’attente « jms/topic/order » et la fabrique de connexion
« jms/petstoreConnectionFactory » ont bien été créées.

Une autre maniére consiste a se rendre sur la console d’administration de GlassFish.
Les ressources JMS se trouvent aux emplacements suivants :
¢ Resources — JMS Resources — Connection Factories

¢ Resources — JMS Resources — Destination Resources
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Common Tasks

_‘ Registration
Application Server
> Applications
Q Web Services
» 3 s8I

Custom MBeans
v [ﬁ) Resources

> 19 JDBC
v 3 ;
> [ﬁ Connection Factories

;j jms/petstoreConnectionFactory

v Destination Resources
;f jmsitopic/order
JavaMail Sessions
> [ ] JNDI
> E:ﬂ Connectors

> @ﬂ Configuration

Figure 5-8: JMS Resources

5.7 Créer les loggers

Les loggers sont utilisés par I’application pour générer des traces (messages d’erreur,
informations de debug, audit, etc.).

Exécutez la tache « set-loggers » pour créer les loggers de chaque composant (petsore,
barkbank, petex) :

{yapson_home}> ant -f admin.xml set-loggers

[exec] server.log-service.module-log-levels.property.com.yaps.petstore = FINEST

[exec] server.log-service.module-log-levels.property.com.barkbank = FINEST

[exec] server.log-service.module-log-levels.property.com.petex = FINEST

La console d’administration de GlassFish vous permet de vérifier la présence des loggers.
Rendez-vous a I’emplacement suivant :

Application Server — Logging — Log Level

La page « Log Levels » présente la section « Additional Properties » dans laquelle sont
définis les loggers :
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Additional Properties (3)
@J LE_J Delete Properties

l ‘ Name 4 l Value £
] com.yaps petstore FINEST
[C] [com petex FINEST
[T] [com barkbank FINEST

Figure 5-9: Loggers de Yaps

5.8 Fin de la configuration

A ce stade, nos environnements GlassFish et Derby sont configurés pour accueillir
I’application Yaps.

Le reste du processus de configuration va se poursuivre sous NetBeans.

Vous allez maintenant stopper le serveur de base de données Derby et le domaine « petstore ».
Ceux-ci seront démarrés en temps voulu sous NetBeans.

5.8.1 Stopper le serveur Derby

Exécutez la tache Ant « stop-db » pour stopper le serveur de base de données Derby :

{yapson_home}> ant -f admin.xml stop-db

[exec] Command stop-database executed successfully.

5.8.2 Stopper le domaine « petstore »
Exécutez la tache Ant « stop-domain » pour stopper le domaine applicatif « petstore » :

{yapson_home}> ant -f admin.xml stop-domain

[exec] Domain petstore stopped.
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6 Configurer NetBeans

Avant de procéder au portage des projets Yaps sous NetBeans, il est nécessaire de configurer
I’IDE.

Veuillez démarrer NetBeans comme décrit dans la section 3.2.3.

6.1 Serveur « Petstore »

6.1.1 Ajout du serveur « Petstore »

Vous allez procéder a I’ajout d’un serveur de type GlassFish v2 qui sera li¢ au domaine
« petstore » que vous avez précédemment créé.

Par défaut, le serveur GlassFish v2 défini sous NetBeans est configuré avec le domaine
« domainl ».

Sélectionnez I’onglet « Services » et ensuite un clic droit sur le nceud « Servers » :

: Projects ‘ Files

@& Databases

& 99 web services

E\ @ Enterprise Beans (2.x)

=
@ @% Apz Add Server...
&% GlassFish V2

@»6 GlassFish V3

@[3 WEBrick (Built-in JRuby 1.1.4)

Figure 6-1: Liste des Services

Le menu contextuel apparait et vous permet d’ajouter un nouveau serveur.

Cliquez sur I’option « Add Server... ».

6.1.1.1 Type de serveur

La premiere étape du wizard consiste a définir le type de serveur d’applications.

Dans notre cas, il s’agit de « GlassFish v2 » :
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Croveime TR ==

Server: |BEA WebLogic Server
GlassFish V1

GlassFish V3 Prelude

IBM WebSphere Application Server V6.0
IBM WebSphere Application Server V6.1
JBoss Application Server

Sailfin V1

Sun Java System Application Server 8.2
Tomcat 5.0

Tomcat 5.5

Tomcat 6.0

'Petshore

Figure 6-2: Type de serveur
Dans le champ « Name », veuillez nommer le serveur « Petstore ».

Ce nom est arbitraire et ne sert qu'a identifier le serveur parmi la liste définie sous NetBeans.

Cliquez sur « Next » pour continuer.

6.1.1.2 Sélection du domaine
Dans cette étape, vous allez lier notre domaine « petstore » au serveur « Petstore ».

Sélectionnez I’option « Register Local Default Domain » et ensuite le domaine « petstore » :
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Qs R ==
NN

Steps Platform Folder Location }
1. Choose Server Specify the location of the platform folder associated with the domain being
2. Platform Folder Location registered.

3. Domain Admin Login Info
Platform Location: |C:\Program Files\glassfish-v2ur2

(@) Register Local Default Domain

' Domain: ﬂocalhost.ﬂm M Q v,
localhost:4848(... \domains\domain 1)

© Register Local Dom| Ry e T ]

() Register Remote Domain

(7) Create Personal Domain

Profile: :Default

| <Back || MNext> || Finish || Cancel || Hep |

Figure 6-3: Choix du domaine

Cliquez sur « Next » pour continuer.

Domaine "petstore'" introuvable

Si "petstore" n'apparait pas dans la liste des domaines, il peut s'agir d'un probléme de
localisation de la plateforme GlassFish.

Ce probléme peut apparaitre lorsque NetBeans trouve une autre version de GlassFish
préalablement installée sur votre systeme.

Pour résoudre ce probléme, sélectionner - a partir du champ "Platform Location" - le
répertoire GlassFish correspondant a notre environnement (voir section 3.2.2.4).

6.1.1.3 Profil de ’administrateur
Cette étape consiste a identifier le profil de I’administrateur :
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PEEERE )

Steps Domain Admin Login Info

1. Choose Server Enter the user name and password that the IDE should use to authenticate domain
2. Platform Folder Location administration commands.

3. Domain Admin Login Info
Admin Username:  admin

Admin Password: eeesssse

If you specify a user name and password, the values will be stored in your user
directory, which is a security risk. If you leave the fields blank, you will be prompted
for the values when needed.

Next > [ Finish ][ Cancel ][ Help ]

Figure 6-4: Paramétres de l'administrateur

Veillez a introduire le mot de passe que vous avez défini plus haut lors de la création du
domaine (voir section 5.2).

Cliquez sur le bouton « Finish » pour terminer le processus de création du serveur applicatif.

6.1.2 Liste des serveurs
La liste des serveurs fait maintenant apparaitre notre serveur « Petstore » :

: Projects |: Files
#- & Databases

@ Web Services

@ Enterprise Beans (2.x)
El Servers

-5 Apache Tomcat 6.0.18

& GlassFish V2

@& GlassFish V3

v

[l WEBrick (Built-in JRuby 1.1.4)

Figure 6-5: Liste des serveurs
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6.1.3 Affichage des traces

Avant de démarrer le serveur « Petstore », vous devez vous assurer que les traces seront

visibles.

Un click droit sur le serveur « Petstore » permet d'activer 1'affichage des traces.

Cliquez sur l'option « View Server Log » du menu contextuel :

: Projects ‘ Files

|§Se|

#- & Databases
w38 Web Services
+-@ Enterprise Beans (2.x)

El--v Servers
@& Apache Tomcat 6.0.18

-, GlassFish V3

G&-[3 WEBI

Start

Restart
Sto p

Refresh
Remove

View Server Log

Properties

Figure 6-6: Afficher les traces

6.1.4 Démarrer le serveur Petstore

Start in Debug Mode
Start in Profile Mode

View Admin Console

View Update Center

Vous pouvez maintenant démarrer le serveur « Petstore » en sélectionnant 1'option « Start »

du menu contextuel :
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: Projects ': Files [: se
#- & Databases
@ Web Services
@ Enterprise Beans (2.x)
E] Servers
- Apache Tomcat 6.0.18

i-&C GlassFish V3
R OflPetstore
o[ WEB Start

Start in Debug Mode
Start in Profile Mode
Restart

Stop
Refresh

Figure 6-7: Démarrer le serveur

La fenétre « Output » de NetBeans permet de suivre le processus de démarrage du domaine
« petstore » :

: OQutput

=

@ K @

4 | Java DB Database Process % | Petstore & ‘

WEBO11l4: SSO is disabled in virtual server [server]

WEBO1l4: SSO is disabled in virtual server [_ asadmin]

ADM1078: Initialization of AMX MBeans started

ADM1504: Here is the JMXServiceURL for the Standard JMHConnectorServer:
ADM150€: Status of Standard JMX Connector: Active = [true]

WEBO302: Starting Sun-Java-System/Application-Server.

JBIFW0010: JBI framework ready to accept reguests.

WEB0712: Starting Sun-Java-System/Application-Server HITP/1.1l on 8080
WEB0712: Starting Sun-Java-System/Application-Server HTITP/1.1l on 8181
WEB0712: Starting Sun-Java-System/Application-Server HTITP/1.1l on 8282
SMET0007: Self Management Rules service is enabled

Application server startup complete.

SEC504¢€: Audit: ARuthenticaticon refused for [admin].

Figure 6-8: Fenétre "Qutput"

¢

Fenétre « Output » : Affichage

Si la fenétre « Output » n'est pas visible, activez la au travers du menu :

Window — Output — Output

Vous constaterez que la fenétre « Output » contient deux sous-fenétres :
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* Petstore: affiche les traces du domaine « petstore »

* Java DB Database Process: affiche les traces de la base de données Derby

Si I'on explore la sous-fenétre « Java DB Database Process », on constate que le démarrage du
domaine « petstore » a automatiquement démarré le serveur de base de données Derby :

: Output
Java DB Database Process % l Petstore sel

Security manager installed using the Basic server security peolicy.
Apache Derby Network Server - 10.4.1.3 - (€4873%9) started and ready to accept connections on port 1527

Figure 6-9: Démarrage automatique de Derby

¢

Fenétre « Output » : Menu contextuel

La fenétre de trace offre un menu contextuel accessible via un click droit :

: Output

4 [ Java DB Datab Process sc‘ Petstore 2 ‘

mmmm s — e e e e T e e
DI} CORES0598: AS Socket Service Initialization has been completed.
[y | CORES07&: Using [Java HotSpot (TM) Client VM, Version 1.6.0_10] Zrom [Sun Micro
Lj SEC1002: Security Manager is OFF.
X
C:/Pregram Files/glassfish-vZurZ/domains/petstorrf-=—si-t DAL R RIS
@ ADM0001:SuncneInterceptor is now enabled Start
SEC1143: Loading policy provider com.sun.enterpr Start in D&bug Mode [
WEBO114: SSO is diszbled in wvirtual server [serv
WEB0114: SSO is disabled in virtual server [__as Restart
ADM1079: Initialization of AMX MBeans started Stop
ADM1504: Here is the JMXServiceURL for the Stand Refresh i
ADM1506: Status of Standard JMX Connector: Activ
WEB0302: Starting Sun-Java-System/Application-Se Copy Ctrl+C
- £
JBIFW0010: JBI framework ready to accept regquest Find... Ctrl+F
WEB0712: Starting Sun-Java-System/Application-Se
WEB0712: Starting Sun-Java-System/Application-Se Find Next F3
WEB0712: Starting Sun-Java-System/Application-Se Wraptext Ctrl+R
SMGTO0007: Self Management Rules service is enabl
Application server startup complete. Save As... Ctrl+S
SEC504&: Audit: Ruthentication refused for [admi Clear Ctrl+L
Close Ctrl+F4
< n

Figure 6-10: Menu contextuel de la fenétre QOutput

En plus de proposer les options d’arrét (Stop) ou de démarrage du serveur (Start), il est
¢galement possible de rechercher une chaine de caracteres (Find) ou d’effacer le contenu de
la fenétre (Clear).

6.1.5 Explorer les ressources

Une exploration du serveur « Petstore » permet de découvrir les éléments déployés dans le
domaine tels que les applications, les ressources JMS ou les ressources JDBC :
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B Servers
% Apache Tomcat 6.0.18

-.&%, GlassFish V2

€ GlassFish V3

&

. @-E3 Applications

=9 Resources

=- & IbBeC

. B-E3 IDBC Resources
. B jdbc/_TimerPool

----- & jdbc/__default

----- & jdbc/petstoreDS

P & jdbc/__callFlowPool

5-E Connection Pools

----- & _ calFlowPool

----- & _ TimerPool

vvvvv & DerbyPool

----- & petstorePool

E-}-@ JMS Resources

©-E3 Connection Factories

- 53‘? jms/petstoreConnectionFactory

BD Destination Resources

[ [g  INDI

[ Connectors

EJ['_'j Connector Resources

- r_‘,_,j jms/petstoreConnectionFactory
©-E3 Connector Connection Pools

- ﬁ;j jms/petstoreConnectionFactory
53 Admin Object Resources

----- IVMs

w-{J) 38

Figure 6-11: Exploration du serveur Petstore

6.1.6 Acceés a la console d’administration

L’option « View Admin Console » du menu contextuel du serveur permet d’accéder a la
console d’administration :
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: Projects ‘ Files : Servii
#-& Enterprise Beans (2.x)
Servers

-G Apache Tomcat 6.0. 18

#-&, GlassFish V3

- E-E3 Ap Start
EJ[EP Ees Start in Debug Mode
=

Start in Profile Mode

Restart
Stop
Refresh

Remove

View Admin Console

View Server Log

View Update Center
Properties
[~ JEE Y T S Wy Y T "

Figure 6-12: Acces a la console d'administration

NetBeans utilise le browser pour ouvrir la console d’administration : http://localhost:8282

6.2 Changer de browser
En modifiant les options de NetBeans, il est possible de changer le browser par défaut.

Sélectionnez le menu « Tools — Options » :
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% | B a B e € L

General Editor Fonts & Colors Keymap PHP C/C++ Miscellaneous

Web Browser: <Defa tem Browser > v Edit...
<Default System Browser >

Internet Explorer
Firefox

Proxy Settings:
(@ Use System Proxy Settings
() Manual Proxy Settings

HTTP Proxy: Port:

More...

Usage Statistics: Help us improve the NetBeans IDE by providing anonymous usage data

The usage statistics help us better understand user requirements and prioritize improvements in future releases. We will never
reverse-engineer the collected data to find specific details about your projects.

Learn more

ok J[ concel J[ Heb |

Figure 6-13: Options de NetBeans

Dans les options générales (General), vous €tes libre d’opter pour un browser et méme d’en
définir en cliquant sur le bouton « Edit... » :
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(] Web Browsers

Web Browsers:

<Default System Browser > Name: [<Default System Browser >

Internet Explorer
Firefox

Process: 'C:\Program Files\Mozilla Firefox\firefox.exe

Arguments: | fJRL}

Arguments Hint

Figure 6-14: Options du browser

On constate qu’il est notamment possible d’ajouter les définitions d’autres browsers.

6.3 Base de données

Le nceud « Databases » de I’onglet « Services » répertorie les serveurs de base de données et
les connexions:

: Projects : Files | Services @ =
: - [3 MySQL Server at localhost: 3306 [root] (disconnected)
- [§@ JavaDB
- [)) Drivers
Eij jdbc:derby:/flocalhost: 1527/sample [app on APP]
Eﬁj jdbc:derby: /flocalhost: 1527/travel [travel on TRAVEL]
[&j jdbc:derby: /flocalhost: 1527 fvir [vir on VIR]
@ Web Services
@ Enterprise Beans (2.x)
Servers

Figure 6-15: Databases sous NetBeans
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6.3.1 Arrét et démarrage du serveur de base de données

Vous avons vu que le démarrage du serveur “Petstore” démarrait automatiquement le serveur
de base de données Java DB.

Il peut étre utile de démarrer et stopper manuellement le serveur Java DB.

Ces opérations sont accessibles au travers du menu contextuel 1i¢ au nceud Java DB :

: Projects l Files | Services a =
B & Databases

: # . ‘ MySQL Server at localhost: 3306 [root] (disconnected)
(8

~I 4 Drive Start Server

G &3 jdbe:

= [app on APP]

Stop Server
_ E,_‘.j jdbc: [travel on TRAVEL]
- @3-E] jdbc: Create Database... | VIR]
@@ Web Sert Properties...

+

-8 Enterprisé Beans (2.x)
&-[af Servers

[} 1]

Figure 6-16: Menu contextuel de Java DB

6.3.2 Vérifier les propriétés

Pour vérifier les propriétés définies sur un serveur de base de données, sélectionnez I’option
« Properties » du menu contextuel :

: Projects i Files : Services asx
=8 § Databases
' |+} [j MySQL Server at localhost:3306 [root] (not connected)

..... ’

t- [ Drivers Start Server
E*Eﬂ jdbc:de Stop Server 'app on APP]
w-[&F idbc:de ravel on TRAVEL]
@E-::] jdbc:de Create Database... | VIR]

i[53 jdbeimi Properties... Default schema]

w-G® Web Services
@ Enterprise Beans (2.x)

&[5 Servers

Figure 6-17: Accés aux propriétés de Java DB

Le menu « Properties » permet d’accéder aux propriétés définies par NetBeans pour le serveur
de base de données.
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CEECRS

Specify the folder where Java DB is installed and the folder where you will keep your databases. The
database location folder will be used as the value of the derby.system.home property.

Java DB Installation: |C:\Program Files\Sun\JavaDB
Database Location: vC:\Users\eloudsa\.netbeans-derby ‘

Figure 6-18: Propriétés de Java DB

Les propriétés de Java DB vous apprennent que NetBeans utilise des répertoires autres que
ceux attendus par notre configuration.

Pour étre conforme a notre déploiement (voir section 5.5.3), vous devez vérifier et modifier le
cas ¢échéant les répertoires suivants :

¢ Java DB Installation : %GLASSFISH_HOME%\javadb
* Database Location : %GLASSFISH_HOME%\javadb

Crvrr L =

Specify the folder where Java DB is installed and the folder where you will keep your databases. The
database location folder will be used as the value of the derby.system.home property.

Java DB Installation: vC:\Program Files\glassfish-v2ur2\javadb ‘
Database Location: |C:\Program Files\glassfish-v2ur2\javadb

Figure 6-19: Modification des propriétés
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Appuyez sur le bouton “OK” pour valider la modification.

4
Modifications de propriétés de Java DB

La modification des propriétés de Java DB entraine automatique 1’arrét du serveur de base
de données:

: Output
Java DB Database Process % | petstore %

Security manager installed using the Basic server security policy.
Apache Derby Network Server - 10.4.1.3 - (€48739) started and ready to accept connections con port 1527
Apache Derby Network Server - 10.4.1.3 - (€48739) shutdown at 2008-11-29 16:09:30.282 GMT

Figure 6-20: Arrét automatique de Java DB

Le serveur de base de données devra donc étre redémarré :

: Projects [ Files r
=-E& Databases
- (@ MysQL Server atlocalhost: 3306 [rc
)
i) Drive Start Server
iE'::] jdbe: Stop Server ¥
- @-[&3 jdbed
: -85 jdbe
-8 Web Ser Properties...
#-@ Enterprise Beans (2.x)

@ Servers

Figure 6-21: Démarrer Java DB

Create Database...

6.3.3 Connexion vers la base de données

Bien que la data source et le schéma de la base soit déja créée, il est possible d’utiliser
NetBeans pour consulter et manipuler les données du schéma de la base « petstoreDB ».

Mais a ce stade, le schéma de base de données n’a pas encore été créé.

Cette opération sera réalisée plus tard lorsque les directives JPA attachées aux Entity auront
généré les différentes tables de I’application Yaps.

6.4 Conclusion
NetBeans est configuré et prét a accueillir les projets de 1’application Yaps.

Dans la suite du document, nous allons décrire le processus d’importation des
projets suivants :

e BarkBank
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* PetEx
*  Yaps-Server

*  Yaps-Client

Version: 0.07 Page 59/171
Published on: 01-Oct-2009



I N © A T E K

----------------- ¢ The way to your IT projects
YAPS Pet Store sous NetBeans

7 Importer le projet BarkBank

Le projet BarkBank est une application Web (« Web Applications ») exposant le Web Service
« ValidationService » chargé de simuler le processus de validation des cartes de crédit.

Nous allons décrire les différentes étapes nécessaires pour importer le projet BarkBank de
I’application Yaps vers NetBeans.

L’ensemble des opérations qui suivent est réalisé sous NetBeans.

7.1 Créer un nouveau projet

7.1.1 Fermeture des projets
Vous allez créer un nouveau de groupe de projets qui sera spécifique a BarkBank.

Si c’est le cas, i1l y a d’abord lieu de fermer I’ensemble des projets actuellement ouverts sous
NetBeans.

Sélectionnez I’onglet « Projects ».

Un clic droit fait apparaitre le menu contextuel. L’option « Project Group — (none) » permet
de fermer I’ensemble des projets ouverts :

New Project... Ctrl+Shift+N

New File...

Open Project... Ctrl+Shift+0

Open Recent Project »

Project Group » © (none)

Build Project Fl11 New Group...

Clean and Build Project  Shift+F11

Run Project F6

Debug Project Ctrl+F5

Set Main Project »
View Java Packages as »

Figure 7-1: Fermer les projets ouverts

7.1.2 Type de projet

Créez un nouveau projet de type « Web Application ».

Pour cela, sélectionnez l'onglet « Project » et créez un nouveau projet via le menu « File —
New Project ».

Le projet que vous allez créer est de type « Java Web — Web Application » :
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Steps Choose Project
1. Choose Project Categories: Projects:
2 . 0 Java
..... [)\ Javaweb &) web Application with Existing Sources
,,,,, (). JavaEe &Y Web Free-Form Application
»»»»» ) JavaME
»»»»» [, PHP
>>>>> ) Ruby
..... L ,L Groovy
----- I C/C++
..... L’L‘ SOA
----- |/ NetBeans Modules
-1}, Samples
Description:
Creates an empty Web application in a standard IDE project. A standard project uses an
IDE-generated build script to build, run, and debug your project.

< Back Finish [ Cancel ][ Help ]

Figure 7-2: Nouveau projet Web Application

Cliquez sur le bouton « Next » pour continuer.

7.1.3 Nom et répertoires
L'écran suivant vous permet de nommer le projet, et de définir le dossier cible:
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Steps Name and Location

L. Choose Project ProjectName:  |BarkBank|
2. Name and Location
3
4

Server and Settings Project Location: |C:\Projects\YapsON

Frameworks
Project Folder:  |C:\Projects\YapsON\BarkBank

[] Use Dedicated Folder for Storing Libraries
Libraries Folder:

Different users and projects can share the same compilation libraries
(see Help for details).

Set as Main Project

[ < Back ][ Next > ] Finish Cancel H Help

Figure 7-3: Nom du projet et répertoire

Les informations a introduire sont les suivantes:

Project Name: BarkBank

Project Folder: C:\Projects\YapsON\BarkBank

4
Project Folder

Le répertoire du projet est donné ici a titre d’exemple et doit correspondre au répertoire ou
vous avez décompressé le fichier d’archives de I’application YapsON (voir section 3.5).

Cliquez sur le bouton « Next » pour continuer.

7.1.4 Configuration du serveur

Cette étape vous permet d’identifier le serveur d’applications « PetStore » (voir section 6.1)
sur lequel sera déployée 1’application BarkBank :
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P

Steps Server and Settings

L. Choose Project Add to Enterprise Application: | <None >
2. Name and Location :

3. Server and Settings

4. Frameworks Server: Petstore 2

Use dedicated library folder for server JAR files

Java EE Version: 'Java EES5 v .

ContextPath: | /barkbank

| <Back || Next> || Finish |[ cancel |[ Hep

Figure 7-4: Configuration du serveur

La configuration utilisée pour le déploiement est la suivante :

Server: Petstore

Context Path: /barkbank

Cliquez sur le bouton « Next » pour continuer.

7.1.5 Les frameworks
La derniére étape consiste a spécifier les frameworks a utiliser.

Dans le cadre du projet « BarkBank », aucun framework spécifique n’est employ¢ :
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PR 2 2 . e
l Steps Frameworks
1. Choose Project Select the frameworks you want to use in your web application.
2. Name and Location
3. Server and Settings [7] visual Web JavaServer Faces j
4. Frameworks [] Spring Web MVC 2.5
[7] JavaServer Faces =
[[] Struts 1.2.9
[7]_Hibernate 3.2.5 i

Next > Fiish || Cancel |[ Hep

Figure 7-5: Frameworks

Appuyez sur le bouton « Finish » pour terminer le processus de création du projet.

7.1.6 Génération du projet
Le projet est maintenant généré et présente I’ensemble des dossiers suivants :

:Projects 4 % |: Files : Services
~ \/» Web Pages
~ & Configuration Files
: lfg Server Resources
-- | /g Source Packages
~ |7 TestPackages
~ @ Libraries
&- & TestLibraries

Figure 7-6: Dossiers du projet

Vous étes prét a importer le code source du projet BarkBank de 1’application Yaps vers
I’arborescence de NetBeans.
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7.2 Transférer le projet sous NetBeans

L’opération de transfert du projet BarkBank consiste a copier les fichiers de I’application
Yaps vers ’application YapsON.

Pour faciliter cette opération, le script Ant « yapson.xml » (décrit dans la section 3.5)
automatise la copie des fichiers.

Assurez-vous d’avoir configuré le fichier « yapson.properties » tel que décrit dans la section
4.

7.2.1 Positionner les variables d'environnement

Les commandes que vous allez exécuter nécessitent de positionner les variables
d’environnement pour 1’exécution des taches Ant.

Rendez-vous dans le répertoire de I’application YapsON et exécutez le fichier de commande
« setenv-yaps.cmd » :

C:> cd {yapson_ home}

{yapson_home}> setenv-yaps.cmd

7.2.2 Transférer le projet

A partir de la ligne de commande, exécutez la tiche « transferBarkBank » chargée de
transférer le projet sous NetBeans :

{yapson_home}> ant -f yapson.xml transferBarkBank

Buildfile: yapson.xml

transferBarkBank:

[echo] Transfer the BarkBank projet to NetBeans

L'exécution du script Ant commence par demander une confirmation avant de procéder au
remplacement des fichiers :

[input] The target source files will be overwritten by the original YAPS project. Do you
want to continue? (y, n)

y

Dans I’affirmative, la tiche Ant copie respectivement les codes sources Java, les fichiers de
ressources Web et les descripteurs :

[echo] === Copy Java Sources ===
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[copy] Copying 1 file to c:\Projects\YapsON\BarkBank\src\java
[echo] === Copy Web Resources ===

[copy] Copying 2 files to c:\Projects\YapsON\BarkBank\web
[echo] === Copy Web Descriptors ===

[copy] Copying 1 file to c:\Projects\YapsON\BarkBank\web\WEB-INF

BUILD SUCCESSFUL

NetBeans rafraichit automatiquement le projet BarkBank :

: Projects a =8 I : Files

E}- /> Web Pages
=-[)) WEB-INF
[ sun-web.xml
PR (& web.xml
E} index.jsp
o @ logo.gif
bl {3 Web Services

E\@ Validation

‘. @ ValidateCard: String

t-| & Configuration Files

-.[@) MANIFEST.MF

I_‘:,ﬂ sun-web.xml

[ web.xml
-1 fg Server Resources
bl g Source Packages

=[5 com.barkbank.validator

[ S

B 1 DO

SO DO —

Y i DOS——

-1 f5 TestPackages
g Libraries
b @ TestLibraries

[+

Figure 7-7: Projet BarkBank aprés le transfert

7.2.3 Créer le groupe de projet
NetBeans offre la possibilité de créer des groupes de projets pour faciliter le passage d'un
projet a l'autre sans avoir a redémarrer 1'IDE.

A partir du menu « File » ou via un clic droit dans la fenétre « Projects », NetBeans offre la
capacité de créer le nouveau groupe de projet:
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: Projects a s | Files : Services
&) BarkBank

New Project... Ctrl +Shift+N

New File...

Open Project... Ctrl +Shift+0

Open Recent Project 4

Project Group » @ (none)
Build Main Project F11 New Group...
Clean and Build Main Project  Shift+F11

Run Main Project Fé

Debug Main Project Ctrl+F5

Set Main Project »

View Java Packages as »

Figure 7-8: Créer un groupe de projet

Sélectionnez I’option « New group ».

La fenétre suivante permet de nommer le groupe de projet qui est dans notre cas BarkBank :

Name: |BarkBank

(@) Free Group
Contains any projects you like. Can be updated manually or automatically.
Use Currently Open Projects

Automatically Save Project List
() Project and All Required Projects
Contains a master project and all projects it requires, recursively.
Master Project:
(7) Folder of Projects
Contains any projects found beneath a given folder on disk.

Folder:

[ Create Group ] [ Cancel l [ Help

Figure 7-9: Nouveau groupe de projet

Les options par défaut indiquent que les projets en cours de chargement dans I’IDE seront
automatiquement ajoutés au groupe de projet BarkBank.

Cliquez sur le bouton « Create Group ».
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7.3 Compiler le projet

Un clic droit sur le projet fait apparaitre le menu contextuel proposant les options pour
compiler le projet (« Build » ou « Clean and Build ») :

: Projects - BarkBank a0 8 l Files

-l W New »

é« & C Build
=g St Clean and Build
@’ i S Clean
Verify

B T Generate Javadoc

Figure 7-10: Compiler le projet

Cliquez sur I’option « Clean and Build ».

Le fenétre « Output » affiche les traces de la compilation :

: Output
> ‘ Java DB base Process % I Petstore 8‘ BarkBank (clean, dist) ® ‘

E—— — -
[] deps-ear-jar:

%% deps-jar:

Created dir: C:\Projects\YapsON\BarkBank\build\web\WEB-INF\classes

Created dir: C:\Projects\YapsON\BarkBank\build\web\META-INF

Copying 1 file to C:\Projects\YapsON\BarkBank\build\web\META-INF

Copying 4 files to C:\Projects\YapsON\BarkBank\build\web
library-inclusion-in-archive:

library-inclusion-in-manifest:

Compiling 1 source file to C:\Projects\YapsON\BarkBank\build\web\WEB-INF\classes
C:\Projects\YapsON\BarkBank\src) 7a \ Av i \Validation.java:86: ing: able character for encoding UTF-8

ava\com\barkbank\validator
/= Methodes Priv?es =

1 warning

compile:

compile-jsps:

Created dir: C:\Projects\YapsON\BarkBank\dist

Building jar: C:\Projects\YapsON\BarkBank\dist\BarkBank.war
do-dist:

dist:

?UILD SUCCESSFUL (total time: 2 secconds)

Figure 7-11: Résultat de l1a compilation

Les messages intéressants sont les suivants :

compile:

compile-jsps:

Created dir: C:\Projects\YapsON\BarkBank\dist

Building jar: C:\Projects\YapsON\BarkBank\dist\BarkBank.war
do-dist:

dist:

BUILD SUCCESSFUL (total time: 2 seconds)
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Ces traces indiquent que le projet a été correctement compilé (« BUILD SUCCESSFUL ») et
archivé dans le fichier « BarkBank.war ».

7.4 Déployer le projet

Vous allez maintenant procéder au déploiement du projet sous GlassFish.

Un clic droit sur le projet fait apparaitre le menu contextuel proposant 1’option de déploiement
(« Deploy ») :

: Projects -... < % |: Files : Services
=R JBarkBank
E- i W New »
G-l W
G- & C Build
fa St Clean and Build
-y S Clean
g T .
w- (@ U HEL
g T Generate Javadoc
Run
Deploy
Debug
Profile
Test RESTful Web Services

Figure 7-12: Déployer le projet

Cliquez sur I’option « Deploy ».
Si nécessaire, NetBeans se charge de démarrer le serveur d’applications « PetStore ».

Si I’application BarkBank était déja déployée sur le serveur, NetBeans se charge de la
supprimer (Undeploying) pour la remplacer par la nouvelle version.

La fenétre « Output » trace les messages suivants :

deployment started : 0%
deployment finished : 100%

Deploying application in domain completed successfully

All operations completed successfully
run-deploy:

BUILD SUCCESSFUL (total time: 4 seconds)
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Le déploiement terminé, vous pouvez explorer le contenu de 1’application BarkBank sur le

serveur PetStore.

Rendez-vous sur I’onglet “Services” et sélectionnez le serveur “Petstore”.

Le nceud « Applications — Web Applications — BarkBank » affiche les ressources et
services exposés par ’application :

: Projects - Bark... |’ Files

a =

0@ -

- & Databases
-4® web Services
-& Enterprise Beans (2.x)
Servers
- Apache Tomcat 6.0.18
- GlassFish V2
- GlassFish V3
Ej 6 pPetstore
. -3 Applications

E} [ Enterprise Applications
=3 Web Applications

58

@) default

G- (3 EIB Modules
-3 Connector Modules
-3 App Client Modules

&9 Resources

, ..... IVMs
- w-{p Br
G3-[i§ WEBrick (Built-n JRuby 1.1.4)

Figure 7-13: Application BarkBank sous GlassFish

L’application BarkBank est accessible a 1'adresse http://localhost:8080/barkbank et se

présente comme suit
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@& Mozilla Firefox == %

amwr o ST
Eile Edit View History Bookmarks Tools Help

@ - C & ([ | nttpi//iocalnost:8080/barkbank/ w ||

Show WSDL | Test WebService |

Figure 7-14: Page d’accueil de BarkBank

A ce stade, vous pouvez inspecter le WSDL ou tester le service tel que décrit dans le livre de
référence.

Domaine introuvable sous Linux ou Mac OSX

Linux et Mac OSX sont case sensitive. Veillez donc a respecter les majuscules et
minuscules dans le nom de domaine "BarkBank".

7.5 Tester le projet

Vous étes maintenant en mesure de tester 1’application BarkBank en invoquant le Web
Service « ValidationService ».

Un Web Service peut étre testé de différentes manieres. Nous allons ici nous contenter de
quelques unes d’entre elles disponibles sous NetBeans.

" 4
Client de test SOAP
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Nous vous recommandons d’évaluer la solution soapUI (http://www.soapui.org), un outil
de test de Web Service.

soapUI est proposé sous deux licences. La version standard est gratuite et distribuée sous
licence Open Source. La version Pro est payante et propose des fonctionnalités avancées.

soapUI peut-étre intégré sous forme de plug-in tant sous Eclipse que sous NetBeans.

Mais nous avons constaté des problémes de stabilités avec le plug-in pour NetBeans
contrairement a la stabilité affichée par la version standalone.

7.5.1 Méthode 1 : Web Service Tester de GlassFish

Au travers de la fenétre « Projects », un clic droit sur le Web Service « Validation » propose
le menu contextuel suivant:

: Projects -... <0 & | Files I Services
=@ BarkBank

i» l» Web Pages

=@ Web Services

=-{9)
@

Open
: "y Configy Refresh Service
~ | fg Serverl
15 Source Add Operation...
G fg TestPa
-\ g Librariet Test Web Service
G| g Testlib

Edit Web Service Attributes

Configure Handlers...

Generate and Copy WSDL...

Generate SOAP-over-HTTP Wrapper

Delete Delete

Properties

Figure 7-15: Tester le Web Service

L'option « Test Web Service » invoque le mécanisme de tests de Web Service de GlassFish
qui a son tour invoque le Web Service « ValidationService » au travers de 'URL suivante:

http://localhost:8080/barkbank/ValidationService?Tester

Ce mécanisme est largement décrit dans le livre de référence.
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7.5.2 Méthode 2 : Web Service Tester de NetBeans

Cette méthode consiste a enregistrer le Web Service sous NetBeans afin de bénéficier d’un
outil de test un peu plus évolué que celui offert par GlassFish.

Les Web Services sont répertoriés dans la fenétre « Services » sous le nceud « Web Service » :

: Projects - Bark... |’ Files
#-E& Databases

o8

t- 1)) Amazon
G-}, Delicious
@), Facebook
G-} Flickr
&), Google
- f Strikelron
G- 1)) Twitter
1)) WeatherBug
@), Yahoo
-1 Zilow
&1} Zvents

#-@ Enterprise Beans (2.x)

él- - Servers

Figure 7-16: Liste des Web Services sous NetBeans
Pour ajouter un Web Service, procédez comme suit.

Vous devez avant tout créer un groupe dans lequel seront stockés les Web Service du projet
YapsON.

Un click droit sur le noeud « Web Services » propose un menu contextuel dans lequel vous
allez créer le groupe « YapsON » par I’option « Create Group » :

: Projects - Bark... | Files
#- & Databases

- @ [EEr=
W Add Web Service...

&1 L) Amaz

i1 Delid Create Group

-1\ Facebook

Figure 7-17: Groupe de Web Services

(] Create Web Service Group @

Name: |YapsON

OK ] [ Cancel

Figure 7-18: Ajout du groupe de Web Service
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Ensuite, un clic droit sur le groupe « YapsON » offre un ensemble d’options parmi lesquelles
celle qui permet d'ajouter un Web Service par I’option « Add Web Service » :

: Projects - Bark... l Files
@& Databases

EJ@ Web Services

-- /) Amazon

-- |}, Delicious

-- |}, Facebook

G- [)) Flickr

~ IJ) Google

-- i Strikelron

G- [)) Twitter

-- I)) WeatherBug

--l_,J_. Yahoo

..... [

@[ zilo Add Web Service...

G 2Zve Create Group
B Enterpril e
#-[2E) Servers

Rename...

Figure 7-19: Ajout d'un Web Service

Le formulaire permet d'identifier le Web Service a partir de son WSDL:

T I =

Specify the file of the Web Service.

@ URL: http://localhost:8080/barkbank/ValidationService?WSDL Set Proxy...
Package Name: | <dlick to override>

Use the Tools->Plugins manager to install the JAX-RPC library for J2EE 1.4 compatibility.

ok |[ cancel |[ Hep

Figure 7-20: Localiser le WSDL

Veuillez localiser le WSDL du Web Service a partir de son URL :
http://localhost:8080/barkbank/ValidationService? WSDL

Cliquez sur le bouton “OK” pour ajouter la référence du Web Service sous NetBeans.
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Le Web Service « ValidationService » est maintenant ajouté a la liste des Web Service :

: Projects - Bark... : Files | Ser
@& Databases
E]@, Web Services
E} /) Amazon
E} ) Delicious
LTJ ), Facebook
- [)) Flickr
1)) Google
E}i StrikeIron
- [0} Twitter
1)) WeatherBug
E} ), Yahoo
E} ). YapsON
BQ ValidationService
=B ValidationPort
| o ) validateCard
G- Zillow Test Method
i - L Zvents
@@ Enterprise Beans (2.X)

Servers

Figure 7-21: Référence de ValidationService

Un clic droit sur l'opération « ValidateCard » permet de tester la méthode au travers de 1’écran

suivant :
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Test Web Service Method:
Enfer e values for e perameters anc press e "Sudmit” buton.
Type Name Value
# java.lang.String creditCardNumber
# java.lang.String creditCardType
# java.lang.String expiryDate

[Gose ] [_reb ]

Figure 7-22: Ecran de test du Web Service

La partie supérieure concerne la requéte a émettre tandis que la partie inférieure se charge
d’afficher le message de retour. Le bouton « Submit » permet d’envoyer la requéte au Web

Service.

Testez le Web Service avec les données suivantes:

creditCardNumber: 1234567890

creditCardType: MC

expiryDate: 11/09
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Test Web Service Method: validateCard
Enter e RIues flor e PIrametars and press e "Submit” buon.

Type Name Value
# java.lang.String creditCardNumber 1234567890
# java.lang.String creditCardType MC
# java.lang.String expiryDate 11/09

Figure 7-23: Requéte de test

Cliquez sur le bouton « Submit » pour envoyer la requéte au Web Service

« ValidationService ».

Les données sont considérées comme valides par le service et le résultat est un message

« OK » :
Results:
Type Value
# java.lang.String IOK

Figure 7-24: Message de retour

Si I'on omet par exemple la date d'expiration, le Web Service retourne un message d'erreur
explicite composé par I’application BarkBank :
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Results:
Type Value
# java.lang.String Expiry date is empty

Figure 7-25: Message d'erreur

7.6 Conclusion

Les sources de 1’application BarkBank ont ét¢ transférées sous NetBeans dans une
arborescence conforme au format préconisé¢ par le Java Blueprints.

Les tests que nous avons réalisés attestent que le Web Service de 1'application BarkBank a été
correctement compilé et est déployé¢ sur le serveur.
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8 Importer le projet PetEx

Le projet PetEx est une application Web (« Web Applications ») exposant le Web Service
« DeliveryService » chargé de simuler le processus de transport des marchandises achetées en
ligne.

Nous allons décrire les différentes étapes nécessaires pour importer le projet PetEx de
I’application Yaps vers NetBeans. Vous noterez que le principe est en tout point similaire au
processus d’importation du projet BarkBank.

L’ensemble des opérations qui suivent est réalisé sous NetBeans.

8.1 Créer un nouveau projet

8.1.1 Fermeture des projets
Vous allez créer un nouveau de groupe de projets qui sera spécifique a PetEx.

Si c’est le cas, il y a d’abord lieu de fermer I’ensemble des projets actuellement ouverts sous
NetBeans.

Sélectionnez I’onglet « Projects ».

Un clic droit fait apparaitre le menu contextuel. L’option « Project Group — (none) » permet
de fermer I’ensemble des projets ouverts :

New Project... Ctrl+Shift+N
New File...
Open Project... Ctrl+Shift+0
Open Recent Project »
Project Group » © BarkBank
. : : (none)
Build Main Project F11
Clean and Build Main Project  Shift+F11 New Group...
) ) Properties of "BarkBank"
Run Main Project F6
) ) Remove "BarkBank"
Debug Main Project Ctrl+F5
Set Main Project »
View Java Packages as »

Figure 8-1: Fermer les projets ouverts

8.1.2 Type de projet

Créez un nouveau projet de type « Web Application ».

Pour cela, sélectionnez l'onglet « Project » et créez un nouveau projet via le menu « File —
New Project ».
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Le projet que vous allez créer est de type « Java Web — Web Application » :

Steps Choose Project
| 1. Choose Project Categories: Projects:

2 . 0 Java
..... [)\ Javaweb &) web Application with Existing Sources
,,,, (). JavaEe &Y Web Free-Form Application
>>>>> I, JavaME
»»»»» [, PHP
>>>>> ) Ruby
vvvvv I} Groovy
vvvvv I C/C++
----- ), SOA
----- |/ NetBeans Modules
-1}, Samples

Description:

Creates an empty Web application in a standard IDE project. A standard project uses an
IDE-generated build script to build, run, and debug your project.

< Back Finish [ Cancel ][ Help ]

Figure 8-2: Nouveau projet Web Application

Cliquez sur le bouton « Next » pour continuer.

8.1.3 Nom et répertoires
L'écran suivant vous permet de nommer le projet, et de définir le dossier cible:
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Steps Name and Location

1. Choose Project Project Name:  PetEx
2. Name and Location
3
4

Server and Settings Project Location: |C:\Projects\YapsON

Frameworks

Project Folder: | C:\Projects\YapsON\PetEx

[7] Use Dedicated Folder for Storing Libraries
Libraries Folder:

Different users and projects can share the same compilation libraries
(see Help for details).

Set as Main Project

[ < Back ][ Next > ] Finish Cancel ][ Help

Figure 8-3: Nom du projet et répertoire

Les informations a introduire sont les suivantes:

Project Name: PetEx

Project Folder: C:\Projects\YapsON\PetEx

4
Project Folder

Le répertoire du projet est donné ici a titre d’exemple et doit correspondre au répertoire ou
vous avez décompressé le fichier d’archives de I’application YapsON (voir section 3.5).

Cliquez sur le bouton « Next » pour continuer.

8.1.4 Configuration du serveur

Cette étape vous permet d’identifier le serveur d’applications « PetStore » (voir section 6.1)
sur lequel sera déployée 1’application PetEx :
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0 New Web Application I_

Steps Server and Settings

Choose Project Add to Enterprise Application: | <MNone =
Name and Location

1.

2.

3. Server and Settings r 1

4. Frameworks Server: |Betstore 25

Use dedicated library folder for server JAR files
Java EE Version: |JavaEES5

Context Path: | /petex

[ < Back H Next > ][ Finish H Cancel ][ Help

Figure 8-4: Configuration du serveur

La configuration utilisée pour le déploiement est la suivante :

Server: Petstore

Context Path: /petex

Cliquez sur le bouton « Next » pour continuer.

8.1.5 Les frameworks
La derniére étape consiste a spécifier les frameworks a utiliser.

Dans le cadre du projet « PetEx », aucun framework spécifique n’est employ¢ :
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O New Web Application @

Steps Frameworks

1. Choose Project Select the frameworks you want to use in your web application.

2. Name and Location

3. Server and Settings [7] visual Web JavaServer Faces <

4. Frameworks [] Spring Web MVC 2.5
[7] JavaServer Faces 2
[[] Struts 1.2.9 =
[]_Hibernate 3.2.5 s

Next> || Finish || cancel || Hep |

Figure 8-5: Frameworks

Appuyez sur le bouton « Finish » pour terminer le processus de création du projet.

8.1.6 Génération du projet
Le projet est maintenant généré et présente I’ensemble des dossiers suivants :

: Projects @ % | Fil
-
-1 f» Web Pages
~- & Configuration Files
----- \fg Server Resources
., |2 Source Packages
~- \[a TestPackages
~- & Libraries
-- & TestLibraries

Figure 8-6: Dossiers du projet

Vous étes prét a importer le code source du projet PetEx de 1’application Yaps vers
I’arborescence de NetBeans.
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8.2 Transférer le projet sous NetBeans

L’opération de transfert du projet PetEx consiste a copier les fichiers de 1’application Yaps
vers ’application YapsON.

Pour faciliter cette opération, le script Ant « yapson.xml » (décrit dans la section 3.5)
automatise la copie des fichiers.

Assurez-vous d’avoir configuré le fichier « yapson.properties » tel que décrit dans la section
4.

8.2.1 Positionner les variables d'environnement

Les commandes que vous allez exécuter nécessitent de positionner les variables
d’environnement pour 1’exécution des taches Ant.

Rendez-vous dans le répertoire de I’application YapsON et exécutez le fichier de commande
« setenv-yaps.cmd » :

C:> cd {yapson_ home}

{yapson_home}> setenv-yaps.cmd

8.2.2 Transférer le projet

A partir de la ligne de commande, exécutez la tiche Ant « transferPetEx » chargée de
transférer le projet sous NetBeans :

$YAPSON-HOMES%> ant —-f yapson.xml transferPetEx

Buildfile: yapson.xml

transferPetEx:

[echo] Transfer the PetEx projet to NetBeans

L'exécution du script Ant commence par demander une confirmation a 'utilisateur avant de
procéder au remplacement des fichiers :

[input] The target source files will be overwritten by the original YAPS project. Do you
want to continue? (y, n)

y

Dans I’affirmative, la tiche Ant copie respectivement les codes sources Java, les fichiers de
ressources Web et les descripteurs :

[echo] === Copy Java Sources ===
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[copy] Copying 1 file to c:\Projects\YapsON\PetEx\src\java
[echo] === Copy Web Resources ===

[copy] Copying 2 files to c:\Projects\YapsON\PetEx\web
[echo] === Copy Web Descriptors ===

[copy] Copying 1 file to c:\Projects\YapsON\PetEx\web\WEB-INF

BUILD SUCCESSFUL

NetBeans rafraichit automatiquement le projet PetEx :

: Projects 4 % |: Files
ER =Y Petex|
Er»- /» Web Pages
- @-l) wesINF
5 ----- (& sun-web.xml
[ web.xml
-] index.jsp
b3 Web Services
: E\[E’] Delivery
: - @ deliverItems: void
S»» & Configuration Files

- i Server Resources
| jg Source Packages
- =[5 com.petex.transport

@. {5 TestPackages
G-\ @ Libraries
g TestLibraries

Figure 8-7: Projet PetEx aprés le transfert

8.2.3 Créer le groupe de projet

A partir du menu « File » ou via un clic droit dans la fenétre « Projects », NetBeans offre la
capacité de créer le nouveau groupe de projet:
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New Project... Ctrl+Shift+N

New File...

Open Project... Ctrl+Shift+0

Open Recent Project >

Project Group » BarkBank
. . . @ (none)

Build Main Project F11

Clean and Build Main Project  Shift+F11 New Group...

Run Main Project F6

Debug Main Project Ctrl+F5

Set Main Project »

View Java Packages as »

Figure 8-8: Créer un groupe de projet

Sélectionnez I’option « New group ».

La fenétre suivante permet de nommer le groupe de projet qui est dans notre cas PetEx :

Name: PetEx|

@ Free Group
Contains any projects you like. Can be updated manually or automatically.
Use Currently Open Projects

Automatically Save Project List
(*) Project and All Required Projects
Contains a master project and all projects it requires, recursively.
Master Project:
(7) Folder of Projects
Contains any projects found beneath a given folder on disk.

Folder:

[ Create Group ] [ Cancel ] [

Figure 8-9: Nouveau groupe de projet

Les options par défaut indiquent que les projets en cours de chargement dans I’IDE seront
automatiquement ajoutés au groupe de projet PetEx.

Cliquez sur le bouton « Create Group ».

8.3 Compiler le projet
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Un clic droit sur le projet fait apparaitre le menu contextuel proposant les options pour
compiler le projet (« Build » ou « Clean and Build ») :

: Projects - PetEx 4 & ‘ Files
=@ [T
New »
Build
Clean and Build
Clean
Verify

Generate Javadoc

Figure 8-10: Compiler le projet

Cliquez sur I’option « Clean and Build ».

La fenétre « Output » affiche les traces de la compilation :

: Output

m DB Database Process i | Petstore i | PetEx (dean,dist) %

Il C:\Frojects\YapsON\PetEx\src\java\com\petex\transport\DeliveryE

b 74

® fr = Methodes Prot?g?es -
Qﬁ% C:\Projects\¥YapsON\PetEx\src\java\com\petex\transport\DeliveryE

[l = Methodes Priv?es =
17 warnings
compile:
compile-jsps:
Created dir: C:\Projects\YapsON\PetEx\dist
Building jar: C:\Projects\YapsON\PetEx\dist\PetEx.war
do-dist:
dist:
BUILD SUCCESSFUL (tetal time: 0 seconds)

Figure 8-11: Résultat de l1a compilation

Les messages intéressants sont les suivants :

compile:

compile-jsps:

Created dir: C:\Projects\YapsON\PetEx\dist

Building jar: C:\Projects\YapsON\PetEx\dist\PetEx.war
do-dist:

dist:

BUILD SUCCESSFUL (total time: 2 seconds)
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Ces traces indiquent que le projet a été correctement compilé (« BUILD SUCCESSFUL ») et
archivé dans le fichier « PetEx.war ».

8.4 Déployer le projet

Vous allez maintenant procéder au déploiement du projet sous GlassFish.

Un clic droit sur le projet fait apparaitre le menu contextuel proposant 1’option de déploiement
(« Deploy ») :

: Projects - PetEx 4 & ] Files

[

New »

-

LUl g il il <l P 9 S

}

Build
Clean and Build

Clean

Verify

Generate Javadoc

G-

. {i#‘ B I |

}

G-

(-

Run

Deploy

Debug

Profile

Test RESTful Web Services

Figure 8-12: Déployer le projet

Cliquez sur I’option « Deploy ».
Si nécessaire, NetBeans se charge de démarrer le serveur d’applications « PetStore ».

Si I’application PetEx était déja déployée sur le serveur, NetBeans se charge de la supprimer
(Undeploying) pour la remplacer par la nouvelle version.

La fenétre « Output » trace les messages suivants :

deployment started : 0%
deployment finished : 100%

Deploying application in domain completed successfully

All operations completed successfully
run-deploy:

BUILD SUCCESSFUL (total time: 4 seconds)
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Le déploiement terminé, vous pouvez explorer le contenu de 1’application PetEx sur le

serveur PetStore.

Rendez-vous sur I’onglet “Services” et sélectionnez le serveur “Petstore”.

Le nceud « Applications — Web Applications — PetEx» affiche les ressources et services

exposés par 1’application :

L’application PetEx est accessible a 1'adresse http://localhost:8080/petex et se présente

comme Suit:

: Projects - PetEx

l? Files

i} &} -

- & Databases
@, Web Services
-&3 Enterprise Beans (2.x)
Servers
Ej% Apache Tomcat 6.0.18
@6 GlassFish v2
DC GlassFish V3
=& Petstore
; EJG Applications
: E)lj Enterprise Applications
E—}Ij Web Applications
: L?J BarkBank

o fF )

: - @ Delivery
-3 EJBModules
I}}Ij Connector Modules
5 - 3 App Client Modules
@[ﬁ? Resources
. ..... JVMS
@ {fp .r
- WEBrick (Built-in JRuby 1.1.4)

Figure 8-13: Application PetEx sous GlassFish

Version: 0.07

Published on: 01-Oct-2009



NORATER
................. s The way to your IT projects

YAPS Pet Store sous NetBeans

[ & Mozilla Firefox sw-——-A, E@'ﬁ

File Edit View History Bookmarks Tools Help

- o ([ | http://localhost:8080/petex/ o -A Google pe
£ Most Visited P Getting Started 7)) Welcome to NetBeans 3, Latest Headlines &) Check Drupal Site
Welcome to PetEx

Show WSDL | Test WebService |

Done » &
— - ~— —

Figure 8-14: Page d’accueil de PetEx

A ce stade, vous pouvez inspecter le WSDL ou tester le service tel que décrit dans le livre de
référence.

8.5 Tester le projet

Nous sommes maintenant en mesure de tester I’application PetEx en invoquant le Web
Service « DeliveryService ».

Un Web Service peut étre testé de différentes manieres. Nous allons ici nous contenter de
quelques unes d’entre elles disponibles sous NetBeans.
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8.5.1 Méthode 1: Web Service Tester de GlassFish

Au travers de la fenétre « Projects », un clic droit sur le Web Service « Delivery » propose le
menu contextuel suivant:

: Projects - PetEx 4 & ] Files I Services
=& PetEx
\i}»- /» Web Pages
\3 {3 Web Services
: . @ de Open
G| & Configurat

: Refresh Service
+ | kg Server Reg

‘3‘ {1 Source Pac Add Operation...
G| fg TestPacks

&g Libraries Test Web Service

&

bl g TestLibrar
Edit Web Service Attributes

Configure Handlers...

Generate and Copy WSDL...

Generate SOAP-over-HTTP Wrapper

Delete Delete

Properties

Figure 8-15: Tester le Web Service

L'option « Test Web Service » invoque le mécanisme de tests de Web Service de GlassFish
qui a son tour invoque le Web Service « DeliveryService » au travers de I'URL suivante:

http://localhost:8080/petex/DeliveryService?Tester

Cette mécanique de test n’est pas vraiment appropriée pour tester le Web Service
« DeliveryService ». La raison est que la requéte a transmettre contient un message complexe.

8.5.2 Méthode 2: Web Service Tester de NetBeans

Cette méthode consiste a enregistrer le Web Service sous NetBeans afin de bénéficier d’un
outil de test un peu plus évolué que celui offert par GlassFish.

Les Web Services sont répertoriés dans la fenétre « Services » sous le nceud « Web Service » :
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: Projects - PetEx : Files
@& Databases
=98 web Services

1)) Amazon
~-.g, Delicious
-- ), Facebook
@[} Flickr
~n}_ Google

~- § Strikelron
- Twitter

~ ), WeatherBug
~ng_ Yahoo
&-Q

: @@ validationService
-0 Zilow

~-.;_ Zvents

@ Enterprise Beans (2.x)
Servers

Figure 8-16: Liste des Web Services sous NetBeans

Le groupe de Web Service « YapsON » a déja été créé précédemment.
Nous allons nous concentrer sur 1’ajout de la référence du Web Service de PetEx.

Un clic droit sur le groupe « YapsON » offre un ensemble d’options parmi lesquelles celles
permettant d'ajouter un Web Service:

: Projects - PetEx ‘ Files
@& Databases

EJ@, Web Services

: ) Amazon

Delicious
Facebook
Flickr

Google
StrikeIron
Twitter
WeatherBug
Yahoo

HEHEEHEEHEEEE

QQ_ Add Web Service...

Zil Create Group

) v Delete

#-@ Enter
i server Rename...

|

Figure 8-17: Ajout d'un Web Service
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Le formulaire permet d'identifier le Web Service a partir de son WSDL:

Specify the file of the Web Service.

@ URL: http: //localhost:8080 /petex/DeliveryService?WSDL Set Proxy...

Package Name: | <dick to override >

Use the Tools->Plugins manager to install the JAX-RPC library for J2EE 1.4 compatibility.

Figure 8-18: Localiser le WSDL

Veuillez localiser le WSDL du Web Service a partir de son URL :
http://localhost:8080/petex/DeliveryService? WSDL

Cliquer sur le bouton “OK” pour ajouter la référence au Web Service sous NetBeans.

Le Web Service « DeliveryService » est maintenant ajouté a la liste des Web Service :

: Projects - PetEx : Files B
#- & Databases
E‘J@, Web Services
,. /) Amazon
-- I, Delicious
-- |}, Facebook
@) Flickr
,. ), Google
- § Strikelron
-- L Twitter
-- I}y WeatherBug
,. Il Yahoo
=-[)) YapsON
E] @ DeliveryService
. 5B DeliveryPort

= W deliverItems
@@ validationService Test Method

@[ Zzilow

- ) Zvents

#-@ Enterprise Beans (2.x)
#-[5f Servers

Figure 8-19: Référence de DeliveryService

Version: 0.07 Page 93/171
Published on: 01-Oct-2009



I N O A\ T C K

~--------"------E:' The way to your IT projects
YAPS Pet Store sous NetBeans

Un clic droit sur 'opération « deliveryltems » permet de tester la méthode au travers de
I’écran suivant :

[ © Test Web Service Method [B5C

Test Web Service Method: deliverItems
Enter T2 WRIUSS for T DIrameters anc prass e "Submit” bumon.

Type Name Value

E @8 com.petex.transport.DeliveryPlace com.petex.transport.DeliveryPlace@13f5694
|, com.petex.transport.DeliveryPlace |argl com.petex.transport.DeliveryPlace@2d07cc
# java.lang.String arg2

Results:

[ Close H Help ]

Figure 8-20: Ecran de test du Web Service

La partie supérieure concerne la requéte a émettre tandis que la partie inférieure se charge
d’afficher le message de retour. Le bouton « Submit » permet d’envoyer la requéte au Web
Service.

Testez le Web Service avec les données suivantes:

Delivery From City Liege
Contact Said Eloudrhiri
Country BE
State None
Street My street
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Zipcode 1234

Delivery From City Paris
Contact Antonio Goncalves
Country FR
State None
Street Your street
Zipcode 5678

Reference Number 12345678

Test Web Service Method: deliverItems
Enter e WaIUSs for TS DIrameters and prass e "Submit” buton.

Type Name Value
[= |, com.petex.transport.DeliveryPlace  |arg0 com.petex.transport.DeliveryPlace@9539b0
# java.lang.String city Liege
# java.lang.String contact Said Eloudrhiri
# java.lang.String country BE
# java.lang.String state None
# java.lang.String street My street
# java.lang.String zipcode 1234
[= |, com.petex.transport.DeliveryPlace  |argl com.petex.transport.DeliveryPlace@b30577
# java.lang.String city Paris
# java.lang.String contact Antonio Goncalves
# java.lang.String country FR
# java.lang.String state None
# java.lang.String street Your street
# java.lang.String zipcode 5678
# java.lang.String arg2 12345678

Figure 8-21: Requéte de test

Cliquez sur le bouton « Submit » pour envoyer la requéte au Web Service
« DeliveryService ».

La réponse retournée par le Web Service est vide :
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Results:

Type Value
# void

Figure 8-22: Message de réponse
En effet, le code de retour du Web Service « DeliveryService » est de type « void ».

Par contre, le Web Service trace la requéte en utilisant le « logger » applicatif défini pour
« com.petex.transport ».

Si ’on se reporte sur la fenétre « Output » et en particulier sur les traces générées par le
serveur « Petstore », on retrouvera les traces suivantes :

ENTRY
Delivery Order Received

Deliver from DeliveryPlace{contact='Said Eloudrhiri', street='My street', city='Liege',
state="'None', zipcode='1234"', country='BE'}

Deliver to DeliveryPlace{contact='Antonio Goncalves', street='Your street',6 city='Paris',
state='None', zipcode='5678"', country='FR'}

Reference n? 12345678

RETURN

Ces traces montrent que le Web Service a bien recu le message de requéte.

8.6 Conclusion

Les sources de I’application « PetEx » ont été transférées sous NetBeans dans une
arborescence conforme au format préconisé par le Java Blueprints.

Les tests que nous avons réalisés attestent que le Web Service de l'application PetEx a été
correctement compilé et est déployé¢ sur le serveur.
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9 Importer le projet Yaps — coté serveur

Le projet Yaps-Server est une application de type « Enterprise Applications » qui a pour
fonction d’héberger la logique serveur de 1’application Yaps.

Le projet Yaps-Server est composé des modules suivants :
* Module EJB : Entity, Stateless, Statefull, Message Driver Bean
* Module Web : JSF

L’ensemble des opérations qui suivent est réalisé sous NetBeans.

9.1 Créer un nouveau projet

9.1.1 Fermeture des projets
Vous allez créer un nouveau de groupe de projets qui sera spécifique a Yaps-Server.

Si c’est le cas, il y a d’abord lieu de fermer I’ensemble des projets actuellement ouverts sous
NetBeans.

Sélectionnez I’onglet « Projects ».

Un clic droit fait apparaitre le menu contextuel. L’option « Project Group — (none) » permet
de fermer I’ensemble des projets ouverts :

New Project... Ctrl+Shift+N
New File...
Open Project... Ctrl+Shift+0
Open Recent Project »
Project Group » BarkBank
: : : ©  Petkx
Build Main Project F11
) : ) . (none)
Clean and Build Main Project  Shift+F11
) ) New Group...
Run Main Project F6
) ) Properties of "PetEx"
Debug Main Project Ctrl+F5
Remove "PetEx"
Set Main Project »
View Java Packages as »

Figure 9-1: Fermer les projets ouverts

9.1.2 Type de projet

Créez un nouveau projet de type Enterprise Application ».

Pour cela, sélectionnez l'onglet « Project » et créez un nouveau projet via le menu « File —
New Project ».
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Le projet que vous allez créer est de type « Java EE > Enterprise Application » :

= i
O I . =

Steps Choose Project

1. Choose Project Categories: Projects:

) Java J-NMEnterprise Application

| Java Web A Enterprise Application with Existing Sources
Q EJBModule

Q EJB Module with Existing Sources

2,

), JavaEE
) JavaME
| PHP g
J Ruby (E
, Groovy
) ClC++
| soA
, NetBeans Modules
, Samples

Enterprise Application Client
Enterprise Application Client with Existing Sources
Packaged Archive

Description:

Creates a new enterprise application in a standard project. You can also create an EJB module
project and Web application project in the enterprise application. A standard project uses an
IDE-generated Ant build script to build and run your projects.

< Back Finish Cancel ][ Help l

Figure 9-2: Nouveau projet Enterprise Application

Cliquez sur le bouton « Next » pour continuer.

9.1.3 Nom et répertoires
L'écran suivant vous permet de nommer le projet, et de définir le dossier cible:
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Steps Name and Location

1. Choose Project Project Name: | Yaps-Server
2. Name and Location

3. Server and Settings Project Location: |C:\Projects\YapsON

Project Folder: | C:\Projects\YapsON\Yaps-Server

["] Use Dedicated Folder for Storing Libraries
Libraries Folder:

Different users and projects can share the same compilation libraries
(see Help for details).

Set as Main Project

[ < Back ][ Next > l Finish

Figure 9-3: Nom du projet et répertoire

Les informations a introduire sont les suivantes:

Project Name: Yaps-Server

Project Folder: C:\Projects\YapsON\Yaps-Server

4
Project Folder

Le répertoire du projet est donné ici a titre d’exemple et doit correspondre au répertoire ou
vous avez décompressé le fichier d’archives de I’application YapsON (voir section 3.5).

Cliquez sur le bouton « Next » pour continuer.

9.1.4 Configuration du serveur

Cette étape vous permet d’identifier le serveur d’applications « PetStore » (voir section 6.1)
sur lequel sera déployée 1’application PetEx ainsi que les modules (EJB et Web) associés au
projet:
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3. Server and Settings

O New Enterprise Application &
Steps Server and Settings
1. Choose Project s - [ i
erver: Petstore i
2. Name and Location 2

Use dedicated library folder for server JAR files

Java EE Version: :Java EES
Create EJB Module:
Create Web Application Module:
[] Create Application Client Module:

Main Class:

Yaps-Server-gjb
Yaps-Server-war
Yaps-Server-app-dient

yapsserver.Main

La configuration utilisée pour le déploiement est la suivante :

Next

Figure 9-4: Server settings

[ Finish

Server:

Petstore

EJB Module:

Yaps-Server-ejb

Web Application Module:

Yaps-Server-war

Cliquez sur le bouton « Finish » pour terminer le processus de création du projet.

9.1.5 Génération du projet
Le projet est maintenant généré et présente I’ensemble des dossiers suivants :
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: Projects ax|:
& & Yaps-Server
. @& Configuration Files

| fg Server Resources
L@ g Java EE Modules
iﬂ»% Yaps-Server-gjb

| jy Enterprise Beans
@- & Configuration Files
‘| flg Server Resources
& {7 Source Packages
‘| fa TestPackages

| @ Libraries

§ TestLibraries
Yaps-Server-war

|5 Web Pages

-1 & Configuration Files
‘| jg Server Resources
|}y Source Packages
Er- {7 TestPackages
@- § Libraries

B § TestLibraries

@ =581

W{z}‘

Figure 9-5: Dossiers du projet

Vous étes prét a importer le code source du projet Yaps (coté serveur) de I’application Yaps
vers ’arborescence de NetBeans.

9.2 Transférer le projet sous NetBeans

L’opération de transfert du projet Yaps consiste a copier les fichiers de la partie serveur de
I’application Yaps vers I’application YapsON.

Pour faciliter cette opération, le script Ant « yapson.xml » (décrit dans la section 3.5)
automatise la copie des fichiers.

Assurez-vous d’avoir configuré le fichier « yapson.properties » tel que décrit dans la section
4.

9.2.1 Positionner les variables d'environnement

Les commandes que vous allez exécuter nécessitent de positionner les variables
d’environnement pour 1’exécution des taches Ant.

Rendez-vous dans le répertoire de I’application YapsON et exécutez le fichier de commande
« setenv-yaps.cmd » :

C:> cd {yapson home}

{yapson_home}> setenv-yaps.cmd
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9.2.2 Transférer le projet

A partir de la ligne de commande, exécutez la tiche Ant « transferYapsServer » chargée de
transférer le projet sous NetBeans :

%$YAPSON-HOMES%> ant —-f yapson.xml transferYapsServer

Buildfile: yapson.xml

transferYapsServer:

[echo] Transfer to NetBeans the server part of the Yaps project

L'exécution du script Ant commence par demander une confirmation a l'utilisateur avant de
procéder au remplacement des fichiers :

[input] The target source files will be overwritten by the original YAPS project. Do you
want to continue? (y, n)

y

La tache Ant copie ensuite les €léments requis pour le module « Yaps-Server-ejb » :

[echo] >>>>>> Module Yaps-Server-ejb >>>>>>
[echo] === Copy Java Sources ===
[echo] entity ...

[copy] Copying 8 files to c:\Projects\YapsON\Yaps-Server\Yaps—-Server—
ejb\src\java\com\yaps\petstore\entity

[echo] exception

[copy] Copying 2 files to c:\Projects\YapsON\Yaps-Server\Yaps—-Server—
ejb\src\java\com\yaps\petstore\exception

[echo] mdb ...

[copy] Copying 2 files to c:\Projects\YapsON\Yaps-Server\Yaps—-Server—
ejb\src\java\com\yaps\petstore\mdb

[echo] stateless

[copy] Copying 9 files to c:\Projects\YapsON\Yaps-Server\Yaps—-Server—
ejb\src\java\com\yaps\petstore\stateless

[echo] statefull

[copy] Copying 3 files to c:\Projects\YapsON\Yaps-Server\Yaps—-Server—
ejb\src\java\com\yaps\petstore\stateful

[echo] util

[copy] Copying 2 files to c:\Projects\YapsON\Yaps-Server\Yaps—-Server—
ejb\src\java\com\yaps\petstore\util

[echo] === Copy Persistence Unit ===

[copy] Copying 1 file to c:\Projects\YapsON\Yaps-Server\Yaps-Server-ejb\src\conf
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Ensuite, les ressources nécessaires pour le module “Yaps-Server-war” sont transférées :

[echo] >>>>>> Module Yaps-Server-war >>>>>>
[echo] === Copy Web Sources ===

[copy] Copying 4 files to c:\Projects\YapsON\Yaps-Server\Yaps—-Server—
war\src\java\com\yaps\petstore\jsf

[echo] === Copy Web Resources ===
[copy] Copying 39 files to c:\Projects\YapsON\Yaps-Server\Yaps-Server-war\web
[echo] === Copy Web Descriptors ===

[copy] Copying 2 files to c:\Projects\YapsON\Yaps-Server\Yaps-Server-war\web\WEB-INF

Pour terminer, les ressources utilitaires sont transférées (dans notre cas le fichier SQL
contenant les données de test) :

[echo] >>>>>> Tools >>>>>>
[echo] === Copy Test data file ===

[copy] Copying 1 file to c:\Projects\Yaps-Server

BUILD SUCCESSFUL

NetBeans rafraichit automatiquement le projet Yaps-Server :
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: Projects @ % | Files

ﬁ Yaps-Server

=69 Yaps-Server-eib

-- /» Enterprise Beans

-- & Configuration Files

----- g Server Resources

g Source Packages

5] com.yaps.petstore.entity
com.yaps.petstore.entity.catalog
com.yaps.petstore.entity.customer
com.yaps.petstore.entity.order
com.yaps.petstore.exception
com.yaps.petstore.mdb.email
com.yaps.petstore.mdb.print
com.yaps.petstore.stateful
com.yaps.petstore.stateless.catalog
com.yaps.petstore.stateless. customer
com.yaps.petstore.stateless.order
com.yaps.petstore.util

B f5 TestPackages

- g Libraries

&- |® TestLibraries

©-&-8-g-g-u-a-8-g-u-u-a
EREEEEEEEBBE

=&Y Yaps-Server-war

G-\ Web Pages

-- & Configuration Files

----- g Server Resources

E} Source Packages

EE] com.yaps.petstore.jsf
-- | /7 TestPackages

-- & Libraries

- & TestLibraries

Figure 9-6: Projet Yaps-Server aprés le transfert

¢

Ouverture des modules

Il se peut que les modules du projet Yaps-Server soient fermés :

:Projects - Y... < % |:Files

= & Yaps-Server
~ & Configuration Files
----- g Server Resources
E} v Java EE Modules

----- () Yaps-Server-war.war

...... Q Yaps-Server-gjb.jar
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Figure 9-7: Modules fermés

Un clic droit sur le module vous permet d’ouvrir le sous-projet dans I’IDE :

‘Projects - Y. @& I Files | Service
= ﬂ Yaps-Server

G-l & Configuration Files

i Server Resources

=% 4 Java EE Modules

-@

----- Q Yaps-Server-ejb.jan Open Project

Remove

Figure 9-8: Ouverture d'un module

9.2.3 Référencer les Web Services
Des erreurs apparaissent dans les modules “Yaps-Server-ejb » et « Yaps-Server-war ».

La cause de ces erreurs est que les références des Web Service des projets « BarkBank » et
« PetEx » sont manquantes.

9.2.3.1 Référencer DeliveryService

Dans le module « Yaps-Server-ejb », la classe « OrderBean » injecte la référence du Web
Service « DeliveryService » issue du projet « PetEx ».

Pour corriger ’erreur, vous allez devoir ajouter le Proxy client du Web Service.

Un clic droit sur le module « Yaps-Server-ejb » fait apparaitre le menu contextuel dans lequel
vous devez sélectionner I’option « New — Web Service Client » :
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Projects 40X I Files I Services

v /A Yaps-Server
B Configuration Files
L@ Server Resources
» [ Java EE Modules
v &Y Yaps-Server-ejb

> gl Enterprise [TV (S Session Bean..

> I Configuraty Build & Message-Driven Bean...

@ Server Rest @
Cl d Build &) Java Class...
» @ Source Pacl ean and Bui B Java Packase..

» [ TestPacka Clean
o ) & Entity Class
» [g Libraries Verify !
: &

> [ Testlibral - Generate Javadoc l;’, Entity Cla.sses from Database...
v @ Yaps-Server-v DWeb SEI’VCQ... .

» (G Web Pages Run £ Web Service Client...

B Configurati  Deploy

(@ Server Res¢ Debug £ Other... |
» g Source Pacl Profile ] I

Figure 9-9: Ajout d'un client Web Service

L’écran suivant vous demande de localiser le WSDL du Web Service :
= = oo
New Web Service Client ‘ — S J

Steps WSDL and Client Location

1. Choose File Type Specify the WSDL file of the Web Service.
2. WSDL and Client Location

() Project: v ' Browse...

(©) Local File: Browse...

(@ WSDL URL:  http://localhost:8080/petex/DeliveryService?WSDL Set Proxy...

Specify a location for the dient.

Project: 'Yaps-Server-ejb

Package: <default package >

Client Style: JAX-WS Style

[] Generate Dispatch code

Next > Finish H Cancel ][ Help

Figure 9-10: Localisation du WSDL
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Dans notre cas, vous devez fournir 'URL du WSDL relatif a I’application PetEx:
http://localhost:8080/petex/DeliveryService? WSDL

¢

Démarrage du serveur PetStore

Assurez-vous que le serveur « Petstore » est démarré, car dans le cas contraire la tache de
création du client Web Service ne pourra localiser I’'URL du WSDL.

Cliquer sur « Finish » pour générer le code du Proxy client du Web Service.

" 4
Localisation du WSDL

Nous aurions pu localiser le WSDL soit par projet ou par fichier.
Par Projet, cela aurait impliqué que le projet PetEx soit également ouvert dans I’IDE.

Par Fichier, cela nécessite de localiser le fichier WSDL généré dans le projet PetEx.

Nous avons préfére illustrer le mode URL pour simuler la situation ou le Web Service serait
déployé sur un serveur distant ?

A la fin du processus de génération, le dossier « Web Service References » est ajouté au
module « Yaps-Server-ejb » et contient le Proxy client du Web Service :
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: Projects 4 % |: Files
- & Yaps-Server

=-Q Yaps-Server-ejb

Fr»' f» Enterprise Beans

{1}

bl {3 Web Service References
E}-@ DeliveryService
E\»-'E DeliveryPort
.. @ deliverItems
+ & Configuration Files

-l g Server Resources
@»- {7 Source Packages
E}» {7 TestPackages
-\ g Libraries

: - & TestLibraries

& @ Yaps-Server-war

Figure 9-11: Proxy client de DeliveryService

¢

Code source du Proxy client

Le code source Java du Proxy client est généré sous le répertoire suivant :

{yapson _home}/Yaps-Server/Yaps-Server-ejb/build/generated/wsimport/client

NetBeans va ensuite automatiquement rafraichir le projet et faire disparaitre les erreurs de
références repérées dans la classe « OrderBean ».

¢

Erreur persistante

NetBeans peut tarder a faire disparaitre l'erreur de la classe "OrderBean".

Dans ce cas, ouvrez la classe "OrderBean" ce qui aura pour effet de forcer le
rafraichissement de NetBeans.

9.2.3.2 Référencer ValidationService

Dans le module « Yaps-Server-war », la classe « ShoppingCartController » injecte la
référence du Web Service « ValidationService » issue du projet « BarkBank ».

Pour corriger ’erreur, vous allez devoir ajouter le Proxy client du Web Service.
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Un clic droit sur le module « Yaps-Server-war » fait apparaitre le menu contextuel dans vous
devez sélectionner 1’option « New — Web Service Client » :

: Projects @ % |: Files |: services
ﬁ Yaps-Server
i Q Yaps-Server-ejb
-
. /5> WebF New »
_I & Confi
----- lg Serve Build
@-g Sourcs  Clean and Build

Web Service Client...
Visual Web JSF Page...
Visual Web JSF Page Fragment...

EEEREE e

o JSP...
\a TzstP Clean HTML
- & Librari
. 8 Verify
- @ Testl Servlet...
Generate Javadoc
Java Class...

Figure 9-12: Ajout d'un client Web Service

L’écran suivant vous demande de localiser le WSDL du Web Service :

O New Web Seﬁe Client @

Steps WSDL and Client Location

1. Choose File Type Specify the WSDL file of the Web Service.
2. WSDL and Client Location

(©) Project: v ' Browse...

(©) Local File: ' Browse...
(@ WSDL URL: 'http://Iocalhost:8080/barkbank/VaIidaﬁonService?WSDL k Set Proxy...

Specify a location for the dlient.

Project: :Yaps-Server-war

Package: \ default package >

ClentStyle: | JAX-WS Style

[ 7] Generate Dispatch code

Next > [ Finish ][ Cancel ][ Help ]

Figure 9-13: Localisation du WSDL
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Dans notre cas, vous devez fournir 'URL du WSDL relatif a I’application BarkBank:
http://localhost:8080/barkbank/ValidationService? WSDL

Cliquer sur « Finish » pour générer le code du Proxy client du Web Service.

A la fin du processus de génération, le dossier « Web Service References » est ajouté au
module « Yaps-Server-war » et contient le Proxy client du Web Service :

: Projects = | Files

E{--/’i\ Yaps-Server

E{% Yaps-Server-gjb

El@ Yaps-Server-war

Er {» Web Pages

E}- (3 Web Service References
2 @ validationService

v &-@ validationPort

@- & Configuration Files

- |jg Server Resources
E}» {7 Source Packages
@,. {7 TestPackages
@- & Libraries

@ § TestLibraries

Figure 9-14: Proxy client de ValidationService

¢

Code source du Proxy client

Le code source Java du Proxy client est généré sous le répertoire suivant :

{yapson _home}/Yaps-Server/Yaps-Server-war/build/generated/wsimport/client

NetBeans va ensuite automatiquement rafraichir le projet et faire disparaitre les erreurs de
références repérées dans la classe « ShoppingCartController ».

¢

Erreur persistante

NetBeans peut tarder a faire disparaitre 1'erreur de la classe "ShoppingCartController ".

Dans ce cas, ouvrez la classe "ShoppingCartController " ce qui aura pour effet de forcer le
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rafraichissement de NetBeans.

9.2.4 Créer le groupe de projet

A partir du menu « File » ou via un clic droit dans la fenétre « Projects », NetBeans offre la
capacité de créer le nouveau groupe de projet:

New Project... Ctrl+Shift+N

New File...
Open Project... Ctrl+Shift+0
Open Recent Project >
Project Group » BarkBank
. . . PetEx
Build Main Project F11
: o : ©  (none)
Clean and Build Main Project  Shift+F11
) ) New Group...
Run Main Project F6
Debug Main Project Ctrl+F5
Set Main Project »
View Java Packages as »

Figure 9-15: Créer un groupe de projet

Sélectionnez I’option « New group ».

La fenétre suivante permet de nommer le groupe de projet qui est dans notre cas
Yaps-Server :
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Name: Yaps-Server

@) Free Group
Contains any projects you like. Can be updated manually or automatically.
Use Currently Open Projects

Automatically Save Project List
(©) Project and All Required Projects
Contains a master project and all projects it requires, recursively.
Master Project:
(©) Folder of Projects
Contains any projects found beneath a given folder on disk.

Folder:

[ Create Group ][ Cancel H Help

Figure 9-16: Nouveau groupe de projet

Les options par défaut indiquent que les projets en cours de chargement dans I’IDE seront
automatiquement ajoutés au groupe de projet.

Cliquez sur le bouton « Create Group ».

9.3 Changer le Context Root

Pour étre conforme au livre de référence, vous allez changer le Context Root de 1’application
Web qui a été défini par défaut dans le module « Yaps-Server-war ».

Le Context Root est défini dans le fichier de déploiement « sun-web.xml » qui se trouve
sous :

Yaps-Server-war — Configuration Files — sun-web.xml
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\t}j Yaps-Server-war

3 /> Web Pages

b-| g Web Service References
t-| & Configuration Files

{+

=
: -1}, xml-resources
(@) MANIFEST.MF
kst faces-config.xml
B
[ web.xml

‘I fg Server Resources

-I g Source Packages

+

|5 TestPackages
+
+

-\ @ Libraries
| @ TestLibraries

Figure 9-17: Fichier de déploiement « sun-web.xml »
Le fichier « sun-web.xml » est le descripteur de déploiement Web pour SUN GlassFish.

Editez ce fichier et modifiez I’entrée « Context Root » pour y placer la valeur « /petstore » :

Lc.ﬂsun-webixml* se|
Servlets Security Web Services Messaging Environment XML L‘:é{ Module Details v

Module Details

Context Root : |petstore
Error URL :

HTTP Servlet Security Provider :

ClassLoader

Figure 9-18: Modification du context root

9.4 Créer le fichier de déploiement standard

Avant de déployer ’application, il vous reste a générer le fichier de déploiement standard
« application.xml ».

Pour cela, un clic droit sur le projet « Yaps-Server » propose le menu contextuel suivant dans
lequel vous allez pouvoir ajouter le descripteur de déploiement standard (Standard
Deployment Descriptor) :
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: Projects - Yaps-S...

@ % |; Files |: services

; Q Yaps-Serv
@@ Yaps-Serv

Add Java EE Module... ' l
New » B Standard Deployment Descriptor...

Build ‘ ¥ Other...
Clean and Build

Clean

Verify

Figure 9-19: Ajouter le fichier « application.xml »

L’écran suivant apparait précisant ou résidera le fichier de déploiement :

Steps

{{J New Standard Deployment Descriptor =]
- ——S——N—N—N——-

Name and Location

1. Choose File Type
2. Name and Location

File Name: vapplicaﬁon.xml

Project: 'Yaps-Server

Location: :C:\Projects\YapsON\Yaps-Server\src\conf

Created File: iC:\Projects\YapsON\Yaps-Server\src\conf\applicaﬁon.xml

Next > [ Finish ][ Cancel ] Help

Figure 9-20: Localisation du fichier « application.xml »

Cliquez sur « Finish » pour générer le fichier de déploiement.

Le fichier « application.xml » est généré et associé au projet :
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: Projects - Yaps-S... @ & | Files
=/ Yaps-Server

. =-l& Configuration Files

- i-[8) MANIFEST.MF

ig Server Resources

¢ [y Java EE Modules

#-QQ Yaps-Server-ejb

+-& Yaps-Server-war

Figure 9-21: Fichier « application.xml »

Si I’on consulte le fichier « application.xml », on constate que la section « web » du fichier
met en relation I’URI du projet Web (« Yaps-Server-war.war ») avec le Context Root
« /petstore » que vous avez défini précédemment.

<web>
<web-uri>Yaps-Server-war.war</web-uri>

<context-root>/petstore</context-root>

</web>

9.5 Compiler le projet

Un clic droit sur le projet fait apparaitre le menu contextuel proposant les options pour
compiler le projet (« Build » ou « Clean and Build ») :

: Projects - Yaps-S... <0 & | Files

B N Yaps-Server

w-Q Yaps-Server Add Java EE Module...

- Yaps-Server New 5

Build
Clean and Build

Clean

Verify

Figure 9-22: Compiler le projet

Cliquez sur I’option « Clean and Build ».

La fenétre « Output » affiche les traces de la compilation :
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: Output ® % | JUnit Test Resuits
[l> | ava DB Database Process 3 | Petstore % | Retriever Outputss | PetEx (clean, dist) % L

[] [/ = Methodes Prot?gles =
C:"Projects YapsON' PetEx'srec'java'com'petex transport ' Delivery. jav

/= Methodes Priv?es =
C:"Projects YapsON' PetEx'srec'java'com'petex ' transport ' DeliveryPlac

/= Methodes Prot?gles =
C:"Projects YapsCON' PetEx ' srec'java'com'petex ' transport ' DeliveryPlac

[/ = Methodes Prot?gles =
C:"Projects YapsON' PetEx'srec'java'com'petex transport ' DeliveryPlac

// = Methodes Priv?es =

17 warnings

compile:

compile-jsps:

Created dir: C:"Projects YapsCN' PetEx'dist

Building jar: C:"“Projects YapsCN' PetEx'dist  PetEx.war
do-dist:

dist:

BUILD SUCCESSFUL (total time: 0 secondsd

Figure 9-23: Résultat de 1a compilation

Les messages intéressants sont les suivants :

Building jar: C:\Projects\YapsON\Yaps-Server\Yaps-Server-ejb\dist\Yaps-Server-ejb.jar
Building jar: C:\Projects\YapsON\Yaps-Server\Yaps-Server-war\dist\Yaps-Server-war.war
Building jar: C:\Projects\YapsON\Yaps-Server\dist\Yaps-Server.ear

BUILD SUCCESSFUL (total time: 7 seconds)

Ces traces indiquent que les modules ont été correctement compilés de méme que I’archive de
type EAR.

9.6 Déployer le projet
Vous allez maintenant procéder au déploiement du projet sous GlassFish.

Un clic droit sur le projet fait apparaitre le menu contextuel proposant 1’option de déploiement
(« Deploy ») :
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: Projects - Yaps-S... U & | Files
©-Q YapsSe  AddJava EE Module...
&P Yaps-Se New >
Build
Clean and Build
Clean
Verify
Run
Deploy
Debug
Profile

Figure 9-24: Déployer le projet

Cliquez sur I’option « Deploy ».
Si nécessaire, NetBeans se charge de démarrer le serveur d’applications « PetStore ».

Si I’application Yaps-Server était déja déployée sur le serveur, NetBeans se charge de la
supprimer (Undeploying) pour la remplacer par la nouvelle version.

La fenétre « Output » trace les messages suivants :

deployment started : 0%
deployment finished : 100%

Deploying application in domain completed successfully

All operations completed successfully
post-run-deploy:
run-deploy:

BUILD SUCCESSFUL (total time: 10 seconds)

Le déploiement terminé, vous pouvez explorer le contenu de 1’application Yaps-Server sur le
serveur PetStore.

Rendez-vous sur I’onglet “Services” et sélectionnez le serveur “Petstore”.

Le nceud « Applications — Enterprise Applications — Yaps-Server » affiche les ressources
et services exposés par I’application :
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é} 6 pPetstore
5 E\»ﬂlj Applications
. -3 Enterprise Applications
o
E+@ /petstore
: @ Faces Serviet
@ isp
: @) default
E%-' Yaps-Server-ejb.jar
?'6 CatalogSB
?'@ CustomerSB
@5 OrderSB
?'6 ShoppingCartSB
--# EmailSenderBean
P e ?'6 OrderPrinterBean
-3 Web Applications
-3 EJB Modules
[#- (3 Connector Modules
5 e (= App Client Modules
@ij/ Resources

Figure 9-25: Application Yaps-Server sous GlassFish

9.7 Base de données

Le déploiement de I’application Yaps-Server a eu pour effet de supprimer et de créer les
tables de la base de données « petstoreDB ».

Ces opérations sont réalisées par le biais d’annotations JPA apposées dans les différentes
Entity.
Dans cette section, nous allons montrer comment - au travers de NetBeans - accéder a la

structure et aux données de la base de données « petstoreDB ».

9.7.1 Créer une connexion
La premiere étape consiste a créer une connexion vers la base de données.

Sélectionnez I’onglet « Services » et ensuite un clic droit sur « Databases ».

Le menu contextuel suivant apparait offrant la possibilité¢ de créer une nouvelle connexion :
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: Projects - Yaps-Server : Files | Sel
B- g Databases

New Connection... | [root] (disconnected)

Enable Debug
Disable Debug ple [app on APP]
: avel [travel on TRAVEL]
: I [:J Jdbc derby: //Iocalhost 1527 fvir [vir on VIR]

@ Web Services
. & Enterprise Beans (2.x)

#-[5F) servers

Figure 9-26: Nouvelle connexion DB

Cliquez sur « New Connection ».

L’écran suivant apparait dans lequel vous allez identifier les propriétés de la base de données
« petstoreDB » :

Basic setting

Data Input Mode: (@ Field Entry (©) Direct URL Entry

Name: :Java DB (Network)

Host: localhost
Port: 1527
Database: petstoreDB
User Name: dbuser

Password: sssee

= Lrozoiziniiilil | Database password. |

(see help for information on securtcyTsrsy

Additional Props:
[] Show JDBC URL

Figure 9-27: Nouvelle connexion DB

Dans le formulaire, introduisez les informations suivantes :

Name: Java DB (Network)
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Host: localhost
Port: 1527
Database: petstoreDB
User Name: dbuser
Password: dbpwd

4

Propriétés de la source de données

Les informations de connexion proviennent des propriétés définies durant la création du
Connection Pool (voir section 5.5.1).

Cliquez sur le bouton « OK » pour créer la connexion.

Avant de fermer la fenétre, NetBeans peut vous demander de préciser le schéma de la base de
données :

4 = 1 h
() New Database Connection S
Advanced

For each database connection, the Services window only displays objects from one database schema.
Select the schema of the tables to be displayed.

Select schema: DBUSER

Connection established.

[ OK ][Cancel ][ Help ]

Figure 9-28: Choix du schéma de la DB

Veuillez préciser « DBUSER » et cliquez ensuite sur « OK ».
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Le nceud « Databases » présente la nouvelle connexion

: Projects - Yaps-Server ] Files | Services

- & Databases

5 [; MySQL Server at localhost: 3306 [root] (disconnected)
----- [3 Java DB
-} Drivers

[gij jdbc:derby:/flocalhost: 1527/sample [app on APP]

,. lE_(::l jdbc:derby: /flocalhost: 1527/travel [travel on TRAVEL]
: Eﬁj jdbc:derby: /flocalhost: 1527 /vir [vir on VIR]
@, Web Services
#-@ Enterprise Beans (2.x)

Servers

Figure 9-29: Connexion vers petstoreDB

Chaque connexion est préfixée par une icone qui précise un statut :

¢ Une connexion DB est en cours .@

e Pas de connexion DB IE::I

9.7.2 Connexion a la DB

-- jdbc:derby:/flocalhost: 1527/petstoreDB [dbuser on DBUSER]

Un clic droit sur la connexion fait apparaitre le menu contextuel par lequel vous pouvez vous

connecter a la base de données :

: Projects - Yaps-Server l Files | Services

Bg Databases
- @ [@ MysQL Server atlocalhost: 3306 [root] (disconnected)

(@ JavaDB
-- I} Drivers
-- 24 Ridbc:derby:/flocalhost: 1527/petstoreDB [dbuser on DBUSER]
-8 jdbc:derby:/flocalh Connect...
--lf.:j jdbc:derby:/flocalh Disconnect
; 63-[&3 jdbc:derby:/flocalh
@ Web Services Execute Command...
#-@ Enterprise Beans (2.x)
-[5f Servers Refresh
Delete Delete
Properties

Figure 9-30: Connexion a la DB
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Cliquez sur « Connect » pour vous connecter a la base de données.

Le systeme vous demande d’introduire le mot de passe :

[ O Connect @

Basic setting | Advancedl

User name: dbuser
Password: eeees|

[| Remember password
(see help for information on security risks)

" QK ][ Cancel ][ Help

Figure 9-31: mode de passe de la DB

En cochant I’option « Remember password », le mot de passe ne vous sera plus demandé.

Vous étes maintenant connecté a la base de données :

: Projects - Yaps-Server ‘ Files | Services
- & Databases
- @[ MySQL Server atlocalhost: 3306 [root] (disconnected)

G|}, Drivers
o B
E.j jdbc:derby:/flocalhost: 1527/sample [app on APP]
~ [E—.:ZI jdbc:derby:/localhost: 1527 /travel [travel on TRAVEL]
[Ej jdbc:derby: /flocalhost: 1527 /vir [vir on VIR]
-4® web Services
-@& Enterprise Beans (2.x)

Servers

Figure 9-32: Base de données connectée a NetBeans

9.7.3 Explorer la DB

Les nceuds de la connexion peuvent étre ouverts pour explorer la structure de la base de
données « petstoreDB » :
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: Projects - Yaps-Server : Files | Services
=& Databases
G- [@ MySQL Server atlocalhost: 3306 [root] (disconnected)

----- (@ JavaDB

G- )) Drivers

E—}@ jdbc:derby:/flocalhost: 1527 /petstoreDB [dbuser on DBUSER]
E]_I Tables

w-[1] sEQUENCE

w-[I] T_ADDRESS

w-[] T_CATEGORY

o

..... D

rrrr LASTNAME

»»»» TELEPHONE

----- PASSWORD

..... EMAIL

----- DATE_OF_BIRTH
[ef]] FIRSTNAME
-[ef]] ADDRESS_FK
-] Indexes

[)-__| Foreign keys
-] T_ITEM

&[] T_ORDER

&3-[1] T_ORDER_LINE
&-[] T_ORDER_ORDER_LINE
&[] T_PRODUCT

&[] Views

-] Procedures

Figure 9-33: Structure de petstoreDB

Un clic droit sur une table fait apparaitre le menu contextuel qui permet de visualiser le
contenu de la table ou d’altérer sa structure :
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EJ jdbc:derby:/flocalhost: 1527 /petstoreDB [dbuser on DBUSER]
E_j_] Tables

m-[] SEQUENCE
m-[1] T_ADDRESS
@[] T_CATEGORY
> £ g

----- Ef] 1 View Data...

..... ) L Add Column...
----- el T Refresh

""" £l F Delete Delete
''''' | E
----- Efl] o Grab Structure...
""" el F Recreate Table...
- {efl] A
@00 1 Properties
-] Foreign keys

Figure 9-34: Opérations sur la table

Si vous cliquez sur I’option « View Data », une fenétre apparait et vous donnez la possibilité
d’exécuter des requétes de type SQL et obtenir le résultat de la requéte :

[£] sQL Command 1 w‘ EID|E3] )
Connection: |jdbc:derby://flocalhost: 1527/... | S =N | @ - v|IQ 2L 5I| & & DD| Gz =§| © o
select * from DBUSER.T CUSTOMER
1 |INs|
select * from DBUSER.T_CU % |
HEEBE' &K € > ) ' ragesize: 20 |1 TotalRows: 0
D LASTNAME TELEPHONE PASSW... EMAL
< | 1 »
Figure 9-35: Option "View Data"
Vous constaterez que les tables de la base de données sont vides.
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Nous allons maintenant présenter les méthodes pour charger les données de test de livrées
avec le projet Yaps original.

9.7.4 Données de test

Dans le fichier « build.xml » du projet original Yaps, la tache « db-insert-data » insére des
données de test dans la base de données.

Ce processus d’insertion des données de test est exécuté a chaque déploiement de
I’application.

Durant la phase de transfert (voir section 9.2.2), les données de test ont ét¢ transférées a
I’emplacement suivant :

{yapson_home}\Yaps-Server\data.sql

Nous allons montrer deux méthodes que 1’on peut utiliser sous NetBeans pour charger ces
données de test.

9.7.4.1 Méthode 1 : Chargement manuel des données de test

Cette méthode décrit comment charger manuellement les données de test dans la base de
données en utilisant les opérations offertes dans le service « Database ».

Un clic droit sur le nceud « Table » de la base de données « petstoreDB » présente le menu
contextuel suivant :

: Projects - Yaps-Se... | Files | Services 4
= 5 Databases
Lo j MySQL Server at localhost: 3306 [root] (disconnected)
- [§ JavaDB
@., ) Drivers
- |
| 2- _] Tables Connect...
(] SEQUENCE Disconnect
#-[[1] T_ADDRESS
\++ (] T_caTEGORY Execute Command...
=8 D T_CUSTOMER
. D Refresh
1 ..... m] LOGIN
. LASTNAME Delete Delete
...... . TELEPHONE Properties

Flgure 9-36: Exécuter une commande SQL

Sélectionnez I’option « Execute Command ».

Copiez le contenu du fichier « data.sql » pour le coller dans la fenétre de commande :
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[&] sQL command 1 sa| EID|E3] =)
Connection: ‘jdbc:derby://localhost:1527/... - ’ @} 2@ P?}i ‘ B-8 '|‘Q Q: 5‘[ {P & DD|

1%
i
©
(]

+a -
DELETE FROM T_ORDER_ORDER_LINE;
DELETE FROM T _ORDER _LINE;
DELETE FROM T_ORDER;

DELETE FROM T_ITEM:

DELETE FROM T_PRODUCT:;

DELETE FROM T_CATEGORY;

DELETE FROM T_CUSTOMER;

DELETE FROM T_ADDRESS;

INSERT INTO T CATEGORY (id, name, description) VALUES
INSERT INTO T_CATEGORY (id, name, description) VALUES
INSERT INTO T CATEGORY (id, name, description) VALUES
INSERT INTO T_CATEGORY (id, name, description) VALUES
INSERT INTO T_CATEGORY (id, name, description) VALUES
« | m | »

114:59 | INS |

Figure 9-37: Fenétre de commande SQL

Exécutez les requétes SQL en cliquant sur I’icone & de la toolbar.
La fenétre « Output » trace le résultat de chaque requéte SQL.

Vous pouvez maintenant visualiser le contenu de chaque table en invoquant I’option « View
Data » décrite plus haut.

Par exemple, nous obtenons le résultat suivant pour la table « CUSTOMER » :

[5] SQL Command 1 %] ET3 ]3] =)
Connection: .jdbc:derby:lﬂocalhost:1527/petstoreDB .. B | @ = @ Fq?.i | B-5- | ‘a %_L, ‘5'| ﬁ? Q} DD | &s |:_:_>_=| @ =

select * from DBUSER.T CUSTOMER

1 |ms|

select * from DBUSER.T_CU % |

53] D KK € > ' PageSize: |20 :I Total Rows: 4 (Page 10f 1)

ID LASTNAME TELEPHONE PASSWORD EMAIL LOGIN DATE_OF_BIRTH  FIRSTNAME ADDRESS_FK
1 Fleury 545 12345 marc marc@jboss.org marc May 29, 1971 Marc 1
2 Gates 654046 12 bill bill. gates @microsoft.com bill Feb 16, 1965 Bill 2
3  Jobs 548 157 15 job steve.jobs@apple.com job Nov 30, 1964 Steve 3
4  Goncalves 487 487 21 antoncal antonio.goncalves@gmail.com antoncal May 29, 1871 Antonio 4

Figure 9-38: Contenu de la table "CUSTOMER"
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¢

Exécuter une sélection de commandes SQL

[£] sQL command 1 5

Il vous est également loisible d’exécuter un ensemble de commande.
Dans la fenétre de commande SQL, sélectionnez les commandes a exécuter.

Un clic droit fait apparaitre le menu contextuel avec I’option « Run Selection » :

LLJEE

Connection: |jdbc:derby: /flocalhost: 1527/petstoreDB ... v l B EFED P{;{ | B-8- | Lo 5‘] VNN ‘ &E o

@ =

DELETE FROM T_ORDER ORDER LINE;
DELETE FROM T ORDER LINE; =
DELETE FROM T ORDER;
DELETE FROM T ITEM;
DELETE FROM T PRODUCT; SQL History  Ctrl+Alt+Shift+H
DELETE FROM T CATEGORY;

DELETE FROM T CUSTOMER; Cut Ctrl+X
DELETE FROM T ADDRESS; Copy Ctrl+C

Paste Ctrl+V

Select in 3
INSERT INTO name, description) VALUES (1, 'Fish'
INSERT INTO name, description) VALUES (2, '
INSERT INTO name, description) VALUES (3, '
INSERT INTO name, description) VALUES (4, 'Ca
INSERT INTO name, description) VALUES (5, 'Bixd

Run Selection

<

Figure 9-39: Exécuter une sélection de commandes SQL

On se rend vite compte que le chargement manuel est quelque peu contraignant, car il vous
oblige a répéter les opérations de chargement apres chaque déploiement de 1’application.

Nous allons montrer une autre méthode qui automatise le processus de chargement des

données de test.

9.7.4.2 Méthode 2 : Chargement automatique des données de test

Cette seconde méthode est beaucoup plus élégante, car elle automatise le chargement des
données de test conformément au projet original Yaps.

En inspectant les fichiers de projet Netbeans, vous aurez compris que NetBeans utilise Ant
pour compiler et déployer les applications.

NetBeans offre la possibilité¢ de personnaliser le processus de construction et de déploiement
des applications en offrant au développeur la liberté de modifier le fichier « build.xml » du
projet afin d’exploiter les targets Ant suivants :

pre-init

Called before initialization of project properties

post-init

Called after initialization of project properties

pre-compile

Called before javac compilation

post-compile

Called after javac compilation
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pre-dist Called before archive building
post-dist Called after archive building
post-clean Called after cleaning build products
pre-run-deploy Called before deploying
post-run-deploy Called after deploying

Nous allons enrichir le processus de construction de 1’application Yaps-Server afin d’y insérer
une tache pour ajouter les données de test dans la base de données petstoreDB.

Le fichier « build.xml » va étre enrichi afin d’insérer les données de test apres chaque
déploiement de I’application (post-run-deploy).

Sélectionnez I’onglet « Files » et ouvrez le nceud du projet Yaps-Server :

: Projects - Yaps-Se... | Files a8 I Services
1)) Yaps-Server-ejb

1)) Yaps-Server-war

- @)} buid

- m [ dist

Er ), nbproject

Lol src

- &8 build.xml

@ data.sql
\

5 I} Yaps-Server-ejb

#-1)) Yaps-Server-war

Figure 9-40: Fichiers du projet Yaps-Server

Vous constatez la présence du fichier « data.sql » qui a été transféré du projet original.

Vous allez créer le script Ant « yaps-data.xml » qui sera utilisé pour charger les données de
test.
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¢

Fichier « yaps-data.xml »

L’archive de I’application YapsON est livrée avec le fichier « yaps-data.xml ».

Il n’est donc pas nécessaire de créer ce fichier. Vous €tes libres de le déplacer du répertoire
principal vers le répertoire du projet « Yaps-Server » :

C:\> cd {yapson_home}

{yapson_home}> copy yaps-data.xml Yaps-Server

Sélectionnez le dossier « yaps-Server.

Un clic droit affiche le menu contextuel suivant dans lequel vous allez sélectionner 1’option
« New — Other » :

: Projects - Yaps-Se... | Files a8 ‘ Services
2~
- @-1)) Yaps-Se New » B Standard Deployment Descriptor...
@G YapsSe  Find.. Ctrl+F
@ ()} build ¥ Other...
) dist Cut Ctrl+X
\?. ) nbproje Copy Ctrl+C
il src =
- Paste Ctrl+V
@B} build. xm ) '
z |5 datasq Delete Delete
#-1)) Yaps-Servel
H Rename...
-l Yaps-Servel
Local History »
Tools >
Properties

Figure 9-41; Création d'un nouveau fichier

Pour créer un fichier de type Ant, vous allez choisir I’option « Other — Ant Build Script» :
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16 New File A ﬂ

Ch File Type

Choose File Type Project: | /A Yaps-Server

2,

Categories: File Types:

@) JavaEE HTML File

[ XHTML File

SVG File

JavaScript File

JSON File

Properties File
Cascading Style Sheet
YAML File
Custom Ant Task
Empty File
Folder

Siw A RO Oy

Description:
An empty Ant build script.

< Back Finish

Figure 9-42: Type de fichier « Ant Build Script »

Cliquez sur « Next » pour poursuivre.

Ensuite, entrez le nom du fichier qui sera dans notre cas « yaps-data.xml » :
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CEEEEER s aaaaa

Steps Name and Location

1. Choose File Type

File Name: yaps-data
2. Name and Location

Project: Yaps-Server

Created File: | C:\Projects\YapsON\Yaps-Server\yaps-data.xml

Figure 9-43: Nom du fichier Ant

Cliquez sur « Finish » pour terminer le processus.

Le fichier « yaps-data.xml » s’ouvre maintenant dans 1’éditeur de NetBeans pour vous
permettre de le compléter :

B] yaps-data.xml & I

BB-E-QTFEFfs b H|v ¥(P

<?xml version="1.0" encoding="UTIF-8"2>
<project name="changeme" default="all" basedir=".">

<target name="z

(
;
(
v}
11}
(
v}

</target>
</project>

Figure 9-44: Fichier yaps-data.xml

Nous fournissons ci-dessous le contenu a appliquer au fichier « yaps-data.xml » :

<?xml version="1.0"?2>
<!-- This Ant script is used to load test data on the Yaps Pet Store Database -->
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<project name="Yaps-Data" default="load-data" basedir=".">
<!-- Database properties -->
<property name="db-url" value="jdbc:derby://localhost:1527/petstoreDB" />
<property name="db-driver" value="org.apache.derby.jdbc.ClientDriver" />
<property name="db-userid" value="dbuser" />
<property name="db-password" value="dbpwd" />

<!-- Derby Library location -->
<property name="derby.home" value="C:/Program Files/glassfish-v2ur2/javaDB"/>
<property name="derby.lib" value="${derby.home}/1lib"/>

<!-- Classpath -->
<path id="classpath">

<!-- Derby classes -->

<pathelement location="${derby.lib}/derbyclient.jar"/>
</path>

<!-- Ant task used to load data on the Yaps Pet Store Database -->
<target name="load-data">
<sgl driver="${db-driver}"
url="${db-url}"
userid="${db-userid}"
password="${db-password}"
autocommit="yes"
onerror="continue"
caching="yes"
src="data.sgl">
<classpath refid="classpath"/>
</sql>
</target>

</project>

Nous allons décrire le fichier Ant.

Le script Ant « Yaps-Data » commence par définir un ensemble de propriétés pour identifier :
* Database properties : les propriétés de la base de données « petstoreDB ».
* Derby Library location: le chemin vers les librairies de Derby.

* Classpath : la librairie Derby nécessaire pour importer les données.

Ensuite, la cible « load-data » fournit la tiche SQL utilisée pour charger les données dans la
base de données « petstoreDB » a partir du fichier « data.sql ».

Sauvez les modifications et vérifiez la structure XML du fichier.

Pour cela, un clic droit dans le fichier fait apparaitre le menu contextuel offrant I’option
« Check XML » :
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Run Target »
Format Alt+Shift+F
Check XML Alt+F9

Cut Ctrl+X

Copy Ctrl+C

New Watch... Ctrl+Shift+F7
Toggle Line Breakpoint  Ctrl+F8

Paste Ctrl+V

Tools »
Select in »

Figure 9-45: Vérifier le fichier XML

Maintenant, vous allez modifier le fichier « build.xml » du projet « Yaps-Server » pour
invoquer le script Ant « yaps-data.xml » apres la phase de déploiement du projet.

Toujours a partir de 1’onglet « Files », ouvrez le fichier « build.xml » du projet « Yaps-
Server » :

: Projects - Yaps-Se... | Files a = |
=

Yaps-Server

B

Yaps-Server-gjb
) Yaps-Server-war
build
dist
nbproject
_ src

..... [E] data.sdl
- @) yaps-data.xml
-1 ), Yaps-Server-ejb

.{E}v..{ .

=

+
o Y Y Y Y

- ), Yaps-Server-war

Figure 9-46: Fichier « build.xml » de Yaps-Server

L’objectif étant d’insérer les données de test apres le déploiement du projet, vous allez ajouter
la target Ant « post-run-deploy » dans le fichier « build.xml » :

<!-- After deploying the application, we populate the database with test data -->
<target name="post-run-deploy">

<echo>Load Data on the Yaps Pet Store Database ... </echo>
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<ant antfile="yaps-data.xml" target="load-data"/>

</target>

</project>

La target « post-run-deploy » se charge d’invoquer la cible « load-data » du fichier
« yaps-data.xml ».

Pour vérifier le bon déroulement du processus, 1’instruction « echo » permet d’afficher une
trace sur la console.

V¢érifiez la structure du fichier en invoquant 1’option « Check XML » comme décrite
précédemment.

Sauvez vos modifications.

Si vous déployez le projet comme décrit plus haut (voir section 9.6), vous verrez apparaitre la
trace suivante sur la console :

post-run-deploy:

Load Data on the Yaps Pet Store Database ...

load-data:

Executing resource: C:\Projects\YapsON\Yaps-Server\data.sqgl

91 of 91 SQL statements executed successfully

Ces informations indiquent que 91 requétes SQL du fichier « data.sql » ont été exécutées
durant la phase « post-run-deploy ».

Avec cette méthode, les données de tests seront automatiquement injectées dans la base de
données a chaque déploiement du projet « Yaps-Server ».

9.8 Tester le projet
Le test du projet est largement décrit dans le livre de référence.
On rappellera que I’application Web est accessible a 1’adresse suivante :

http://localhost:8080/petstore
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T e T =

File Edit View History Bookmarks Tools Help
N 4y ([ http://localhost:8080/petstore/ w - ]

£, Most Visited P Getting Started /7)) Welcome to NetBeans ., Latest Headlines @ Check Drupal Site

YAPS Pet Store

si
Yet Another Pet Store e

Birds
Cats
Dogs
Fish
Reptiles

The YAPS Pet Store Demo is a )
fictional sample application. A ——
JAx €L Derty B=
POWERED T
Done > &

Figure 9-47: Page web de I'application

N’oubliez pas de créer un compte utilisateur afin de pouvoir valider le comportement de
I’application :

* Ajout d’articles dans le panier.
* Création et envoi d’un bon de commande.
* Réception d’un email de confirmation.

* Messages de trace produits sur le serveur et mentionnant la réception des messages du
topic JMS.
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L’analyse des traces du serveur Petstore vous permet €galement de suivre le cheminement des
messages et de constater que les Web Services (DeliveryService et ValidationService) sont
bien invoqués.

4
Configuration du serveur SMTP

La classe « EmailSenderBean » du package "com.yaps.petstore.mdb.email" chargée
d’envoyer les emails utilise des constantes pour identifier le serveur SMTP:

private static final String SMTP_HOST = "smtp.free.fr";
private static final String USER = "yaps.petstore";
private static final String PASSWORD = "yapspwd";

Il est nécessaire d’adapter les valeurs de ces constantes en fonction de votre environnement.

Apres la modification, n’oubliez de recompiler et de déployer 1’application.

Bug JMS sous GlassFish v2

Le probléme décrit ci-apres a été corrigé sous GlassFish v2.1.

En consultant les traces du serveur Petstore, on peut rencontrer le message d’erreur suivant:

DirectConsumer:Caught Exception delivering messagecom.sun.messaging.jmg.io.Packet
cannot be cast to com.sun.messaging.jms.ra.DirectPacket

Ce probléme est identifié comme un bug connu par SUN:

http://bugs.sun.com/view_bug.do?bug_1d=6650996

Le probléme est 1i¢ a la maniere dont le JMS Provider et 1’ Application Server sont liés.

Par défaut, la relation est de type « EMBEDDED ». Cela signifie que le serveur
d’applications (GlassFish) et le JMS Provider (Sun Java System Message Queue software)
fonctionnent sous la méme JVM.

Pour contourner le probléme, il est recommandé de changer le type de relation en
« LOCAL ». Ce mode stipule que le JMS Provider est démarré dans sa propre JVM au
moment ou le serveur d’applications est lui-méme démarré.

Pour modifier la configuration du service JMS, procédez comme suit :
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e Démarrer la console d’administration du serveur Petstore sur le site suivant :
http://localhost:8282/

* Dans la partie de gauche, sélectionnez la tiche « Configuration > Java Message
Service » :

Common Tasks
8 Registration

> Q Web Services

» [ B

Custom MBeans
> [@ Resources

v M Configuration
Web Container
EJB Container
v Java Message Service
» [ IMS Hosts
Physical Destinations

* Changer le type de relation de « EMBEDDED » a « LOCAL » :

Configuration = Java Message Service

JMS Service

General properties for the Java Message Service (JMS) service apply only to the af
Connector Resources screens

| Load Defautts | | Ping |

Type:

Whether JMS Service is on local or remote system

* Sauver vos modifications.
* Cette modification nécessite un redémarrage du serveur.

e Redémarrez le serveur Petstore.

Les différents types de relation sont exposés dans la documentation de GlassFish (Sun Java
System Application Server 9.1) disponible a I’adresse suivante :

http://docs.sun.com/app/docs/doc/819-3672/beaob?a=view
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9.9 Conclusion

Les sources du serveur de ’application « Yaps» ont été transférées sous NetBeans dans une
arborescence conforme au format préconisé¢ par le Java Blueprints.

Les tests que nous avons réalisés attestent que 1’application Web, la logique métier et les Web
Services communiquent correctement ensemble.
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10 Importer le projet Yaps — coté client

Le projet YAPS Pet Store est composé de deux interfaces clientes. L’une dite 1égere et
composée d’une interface Web (JSF) et I’autre dite lourde (Java Swing).

Comme nous I’avons vu (voir section 9), le client « 1éger » de type Web est déploy¢ avec les
composants du serveur de I’application Yaps.

Nous allons décrire le processus d’importation du client « lourd » (Java Swing) sous le projet
de type « Java Applications » baptis¢ Yaps-Client.

L’ensemble des opérations qui suivent est réalisé sous NetBeans.

10.1 Créer un nouveau projet

10.1.1 Fermer les projets
Vous allez créer un nouveau de groupe de projets qui sera spécifique a Yaps-Client.

Si c’est le cas, il y a d’abord lieu de fermer I’ensemble des projets actuellement ouverts sous
NetBeans.

Sélectionnez I’onglet « Projects ».

Un clic droit fait apparaitre le menu contextuel. L’option « Project Group — (none) » permet
de fermer I’ensemble des projets ouverts :

New Project... Ctrl+Shift+N
New File...
Open Project... Ctrl+Shift+0
Open Recent Project »
Project Group » BarkBank
PetEx
Build Project F11
. . Yaps-Server
Clean and Build Project  Shift+F11
@ (none)
Run Project F6
B New Group...
Debug Project Ctrl+F5
Set Main Project »
View Java Packages as »

Figure 10-1: Fermer les projets ouverts

10.1.2 Type de projet

Créez un nouveau projet de type « Java Application ».
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Pour cela, sélectionnez l'onglet « Project » et créez un nouveau projet via le menu « File —
New Project ».

Le projet que vous allez créer est de type « Java > Java Application » :

Greror . =
Steps Choose Project
1. Choose Project Categories: Projects:
2 ()} Java - Java Application
-[J} JavaWeb & Java Desktop Application
-[)} JavaEE @ Java Class Library
[} JavaME & Java Project with Existing Sources
= A4 Java Free-Form Project
[ )L PHP
. ; , Ruby
- L) Groovy
-l CfC++
~[)) soa
|, NetBeans Modules
-1 ), Samples
Description:
Creates a new Java SE application in a standard IDE project. You can also generate a main dass
in the project. Standard projects use an IDE-generated Ant build script to build, run, and debug
your project.

Finish Cancel ] ’ Help

Figure 10-2: Nouveau projet Java Application

Cliquez sur le bouton « Next » pour continuer.

Java Desktop Application ?

\/ Nous aurions tendance a opter pour un projet de type « Java Desktop
Application » préconisé pour le développement d’applications de type Swing.

L’application client de Yaps Pet Store est certes de type Swing mais son
fonctionnement a ét¢ enrichi par I’apport d’un framework baptisé XSwing.

Nous avons ainsi préféré rester dans le contexte d’une application Java standard
pour rester dans 1’esprit de ’application originale.

10.1.3 Nom et répertoires
L'écran suivant nous permet de nommer le projet, et de définir le dossier cible :
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Steps Name and Location

L. Choose Project Project Name: Yaps-Client

2. Name and Location
Project Location:  C:\Projects\YapsON

Project Folder: C:\Projects\YapsON\Yaps-Client

[7] Use Dedicated Folder for Storing Libraries
Libraries Folder:

Different users and projects can share the same compilation
libraries (see Help for details).

f S |yapsdient.Main

Set as Main Project

Next > [ Finish H Cancel ][ Help

Figure 10-3: Nom du projet et répertoire

Les informations a introduire sont les suivantes :

Project Name: Yaps-Client

Project Folder: C:\Projects\YapsON\Yaps-Client

Il n’est pas nécessaire de cocher I’option « Create Main Class », car nous allons importer nos
propres codes sources.

¢

Project Folder

Le répertoire du projet est donné ici a titre d’exemple et doit correspondre au répertoire ou
vous avez décompressé le fichier d’archives de I’application YapsON (voir section 3.5).

Cliquez sur le bouton « Finish » pour terminer le processus.

10.1.4 Génération du projet

Le projet est maintenant généré et présente I’ensemble des dossiers suivants :
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: Projects 4 % |: Files

=1 Jg Source Packages

- [l <default package>
E}- {7 TestPackages

: ..[l8 <default package>
-1 g Libraries

4| g TestLibraries

Figure 10-4: Dossiers du projet

Vous étes prét a importer le code source du projet Yaps (coté client) de I’application Yaps
vers ’arborescence de NetBeans.

10.2 Transférer le projet sous NetBeans

L’opération de transfert du projet Yaps consiste a copier les fichiers de la partie serveur de
I’application Yaps vers I’application YapsON.

Pour faciliter cette opération, le script Ant « yapson.xml » (décrit dans la section 3.5)
automatise la copie des fichiers.

Assurez-vous d’avoir configuré le fichier « yapson.properties » tel que décrit dans la section
4.

10.2.1 Positionner les variables d'environnement

Les commandes que vous allez exécuter nécessitent de positionner les variables
d’environnement pour 1’exécution des taches Ant.

Rendez-vous dans le répertoire de I’application YapsON et exécutez le fichier de commande
« setenv-yaps.cmd » :

C:> cd {yapson_ home}

{yapson_home}> setenv-yaps.cmd

10.2.2 Transférer le projet

A partir de la ligne de commande, exécutez la tiche Ant « transferYapsClient » chargée de
transférer le projet sous NetBeans :

%$YAPSON-HOMES%> ant —-f yapson.xml transferYapsClient

Buildfile: yapson.xml

transferYapsClient:

[echo] Transfer to NetBeans the client's side of the Yaps project
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L'exécution du script ANT commence par demander une confirmation a l'utilisateur avant de
procéder au remplacement des fichiers :

[input] The target source files will be overwritten by the original YAPS project. Do you
want to continue? (y, n)

y

La tache Ant copie code source Java du projet :

[echo] === Copy Java Sources ===

[copy] Copying 82 files to c:\Projects\YapsON\Yaps-Client\src\com\yaps\petstore\client

Pour terminer, les librairies sont copiées dans un répertoire spécifique :

[echo] === Copy Libraries ===

[copy] Copying 2 files to c:\Projects\YapsON\Tools\Lib

BUILD SUCCESSFUL

NetBeans rafraichit automatiquement le projet Yaps-Client :
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: Projects a = | Files 7]
[—jdj Source Packages
: E] com.yaps.petstore.dlient.delegate

U;l com.yaps.petstore.dient.locator
-g5 com.yaps.petstore.dient.ui
-§- com.yaps.petstore.dient.ui.catalog.category

“@l] com.yaps.petstore.dlient.ui.catalog.category.event

u;] com.yaps.petstore.dient.ui.catalog.category.model
&3 com.yaps.petstore.dient.ui.catalog.item
-§- com.yaps.petstore.dient.ui.catalog.item.event

@] com.yaps.petstore.dient.ui.catalog.item.model
& com.yaps.petstore.dient.ui.catalog.product
u;l com.yaps.petstore.dient.ui.catalog.product.event

-§- com.yaps.petstore.dient.ui.catalog.product.model
-§5 com.yaps.petstore.dient.ui.common.address

u;] com.yaps.petstore.dient.ui.common.address.event

u;] com.yaps.petstore.dient.ui.common.address.model
-§ com.yaps.petstore.dient.ui.customer

-G com.yaps.petstore.dlient.ui.customer.event

-G com.yaps.petstore.dient.ui.cy
@E’ M- Yaps.pEIStore. clent UL ) 1 va Source Package |

k_iz' com.yaps.petstore.dient.ui.of @ Contains files with 1
~gi-] com.yaps.petstore.dlient.ui.order.event

H-G| com.yaps.petstore.diient.ui.order.model

-G com.yaps.petstore.dient.ui.uti

+

u;] com.yaps.petstore.dient.ui.util.combo
EE] com.yaps.petstore.dient.ui.util.event
. @-§H com.yaps.petstore.dient.util.jms

~- [ TestPackages

-- £ Libraries

[ j TestLibraries

Figure 10-5: Projet Yaps-Client aprés le transfert

10.2.3 Référencer les librairies
Comme on peut le constater, des erreurs apparaissent dans le code source du projet.

Ces erreurs sont causées par 1’absence de librairies requises par le projet :
* Les classes des EJBs du projet Yaps-Server
* Les librairies utilitaires (Apache Commons, Framework XSwing)
* Les librairies IMS
* Les librairies de TopLink

Les références a ces libraires se réalisent en modifiant les propriétés du projet.
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Nous allons décrire comment référencer chacune de ces libraires ainsi que la maniere de créer
certaines d’entre elles sous NetBeans.

10.2.3.1 Référencer les classes de Yaps-Server

L’application Yaps-Client référence un ensemble de classes définies dans le projet
Yaps-Server : entity, stateless, util, exception.

Vous allez ajouter la référence a la librairie contenant les classes construites dans le cadre de
I’application Yaps-Server et plus spécifiquement les classes du module Yaps-Server-ejb.

Un clic droit sur le projet Yaps-Client fait apparaitre le menu contextuel dans lequel vous
allez activer I’option Properties :

: Projects a R |5Files

|
@»dj b New >
B |
@ | Build
&8 | Clean and Build

Clean

Generate Javadoc

Run

Debug

Profile

Test Alt+F6
Set Configuration »

Set as Main Project
Open Required Projects

Close

Rename...
Move...

Copy...
Delete Delete

Find... Ctrl+F
Reverse Engineer...
Versioning »

Local History »

Properties

Figure 10-6: Menu propriétés
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Dans I’écran des propriétés du projet, sélectionnez la catégorie Libraries :

[ ij Project Properties - Yaps-Clien g[

Categories:

O Sources Java Platform: JDK 1.6 (Default) v Manage Platforms...

@ Frameworks :
©  JavaScript Libraries Compile Compie Tests | Run Tests
[}

Build
i @ Compiling Compile-time Libraries:

-~ @ Packaging Name Add Project...

© Documenting

Formatting

Edit

Remove

Move Up

Move Down

Compile-time libraries are propagated to all library categories.

Build Required Projects (Libraries and additional WAR content)

Figure 10-7: Librairies

Dans la partie de droite, cliquez sur le bouton « Add JAR/Folder ».
La boite de dialogue permet de sélectionner la librairie a référencer dans le projet.

Dans notre cas, vous devez retrouver la librairie Yaps-Server-ejb.jar qui se trouve sous le
répertoire Build du projet Yaps-Server :

{yapson_home}\build\Yaps-Server-ejb.jar
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@ Add JAR/Folder - (S
Look in: [ . build - J }E
.. META-INF (@) Use Relative Path:
Yaps-Server-ejb.jar .|Yaps-Server build/Yaps-Server-gjb.jar
() Use Absolute Path:

vC:\Projects\Yaps0N\Yaps-Server\build\Yaps-‘

File name: vYaps-Server-ejb.jar

Files of type: :Classpath Entry (Folder, ZIP or JAR file) - Cancel

Figure 10-8: Librairie de Yaps-Server-ejb

A ce stade, les librairies référencées dans le projet sont les suivantes :

J Project Properties - Yaps-Client N N .

Categories:

Sources Java Platform: JDK 1.6 (Default)

Libraries

Build
Compiling
Packaging
Documenting Compile-time Libraries:

N Groovy & ../Yaps-Server/build/Yaps-Server-eib.jar Add Project...
un

O Web Start
Formatting

Libraries Folder:

Compile | Run | Compile Tests | Run Tests |

Compile-time libraries are propagated to all library categories.

Build Projects on Classpath

Figure 10-9: Liste des libraires
Cliquez sur « OK » afin d’ajouter la référence de la libraire au projet.

En consultant le projet, on constate la disparition des erreurs relatives au référencement des
classes du projet Yaps-Server.
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10.2.3.2 Référencer les librairies utilitaires
En utilisant la méthode décrite précédemment, vous allez référencer les deux librairies

utilitaires transférées du projet Yaps.
Ces deux librairies sont localisées sous le répertoire suivant :

{yapson_home}\Tools\Libs\commons-lang-2.3.jar

{yapson_home}\Tools\Libs\vstm-xcore-0.5.0.jar

(S

|
|
!

J Add JAR/Folder

- 2oEE

Lookin: | ', Lib
(@) Use Relative Path:

] commons-lang-2.3.jar
& vstm-xscore-0.5.0,jar

..|Tools/Lib/commons-lang-2.3.jar, ../Tools/L

() Use Absolute Path:
C:\Projects|YapsON|Tools\Lib\commons-lang

File name: "commons-lang-2.3.jar" "vstm-xscore-0.5.0.jar"

Cancel

Files of type: :Classpath Entry (Folder, ZIP or JAR file)

Figure 10-10: Librairies utilitaires

A ce stade, les librairies référencées dans le projet sont les suivantes:
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O Project Properties - Yaps-Client —Ig
Categories:
- @ Sources Java Platform: |JDK 1.6 (Default) v | Manage Platforms...
i @ Libraries
i @ Compiing pom
: ompile i
- o Packaging pi IRunIComplleTestsIRunTestsI
@ Documenting Compile-time Libraries:
" @ Groovy 8 ../Yaps-Server/build/Yaps-Server-ejb.jar Add Project...
e @ Run' - 8 ../Tools/Lib/commons-ang-2.3.jar -
& O Application 8 ../Tools/Libjvstm-xscore-0.5.0.jar ey
“e @ Web Start Add IARFold
Edit
I} Move Up
Move Down
Compile-time libraries are propagated to all library categories.
Build Projects on Classpath
ok |[ cancel |[ Hep |

Figure 10-11: Liste des librairies

Cliquez sur « OK » afin d’ajouter la référence des libraires au projet.

En consultant le projet, on constate la disparition des erreurs relatives au référencement des
classes d’Apache Commons et du framework XSwing.

10.2.3.3 Référencer les librairies JMS

L’application cliente met en ceuvre un MessageListener JMS pour étre a 1’écoute de la file de
messages.

Il est donc nécessaire de référencer I’ensemble des classes JMS pour permettre a I’application
de se connecter au topic JMS, de souscrire aux messages et de recevoir lesdits messages.

Le fournisseur JMS utilisé par I’application YAPS est celui fourni en standard avec Sun
GlassFish a savoir Sun Java System Message Queue software.

Vous allez ajouter les références aux libraires JMS livrées avec Sun GlassFish.

Sous NetBeans, sélectionnez le menu « Tools > Libraries » :
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Versioning |Tools| Window Help

':Er % Analyze Javadoc

rvices Apply Diff Patch...

Internationalization »

Java Platforms
NetBeans Platforms
Ruby Platforms

Variables

Libraries
Corkonent Libraries

Ruby Gems

Servers

Mobility Deployment
Keystores

Templates

DTDs and XML Schemas
Palette »

Plugins

Options
I

Figure 10-12: Menu Libraries

L’écran suivant montre 1’ensemble des librairies définies sous NetBeans :
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O Library Manager

Libraries location: :Global Libraries

Libraries:

i Swing Layout Extensions
&) Toplink Essentials

Component Libraries
&) ISF 1.1 Design-Time Support - De
&) ISF 1.1 Run-Time Support - Depr
&) ISF 1.1/1.2 Support
& MyLibrary2
i Sun Web UI Components Design-
&) Sun Web UI Components Run-Tin
i Sun Web UI Components Suppor!
&) Web UI Components

Theme Libraries
&) Default Theme
&) Gray Theme
&) Green Theme
&) Web UI Default Theme

Server Libraries

&) MyLibrary
<« | 1 »

[ New Library... ][ Remove ]

m

1

v
A Library Name: 'Absolute Layout
Classpath | Sources | Javadoc
Library Classpath:
C:\Program Files\NetBeans 6.1\java2\modules\ext|\Absolut [ Add JARFolder... ]
[ Remove ]
Move Up
Move Down
< m »
[ OK ] [ Cancel ]

Figure 10-13: Librairies sous NetBeans

Vous allez ajouter une nouvelle librairie.

Cliquez sur le bouton « New Library » pour ajouter une nouvelle libraire de type « Class
Libraries » que nous allons nommer « JMS » :

0 New Library

(S

Library Name:

Library Type: Class Libraries

MS

] [ Cancel

[

Cliquez sur « OK » pour poursuivre.

A ce stade, la libraire JMS est sélectionnée.
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En utilisant le bouton « Add Jar/Folder », vous allez ajouter I’ensemble des fichiers suivants
localisés sous le répertoire de Sun GlassFish :

1. {glassfish-home}/lib/install/applications/jmsra/imqjmsra.jar
{glassfish-home}/lib/appserv-admin.jar
{glassfish-home}/imq/lib/imq.jar
{glassfish-home}/lib/appserv-rt.jar

wobk » D

{glassfish-home}/lib/javaee.jar

' hl
O Library Manager IAI

Libraries location: | Global Libraries =
Libraries:

S IACWS 2.1 | Library Name: | M5

B WG 2.1 pr—
- IDBC Design-Time Support - [ asspath | Sources | Javadoc

&% IDBC Run-Time Support - Dej Library Classpath:

&) Jersey 0.8 (JAGRSRI) C:\Program Files\glassfish-v2ur2\lib\install\applications\jmsra\imqjmsra.jar Add JAR/Folder...

i C:\Program Files\glassfish-v2ur2\lib\appserv-admin.jar
-8B IMUNit4CLDC10 == Wl C:\Program Files\glassfish-v2ur2\imq\lib\img.jar
- IMUNit4CLDC11 C:\Program Files\glassffsh-v2ur2\|ib\§ppserv.-rt.jar
BB F1.2 | C:\Program Files\glassfish-v2ur2\lib\javaee.jar Move Up
- 15TL 1. i
Move Down
&y Junit 3.8.2
& Junit 4.1

& MySQL IDBC Driver

& NetBeans DataBindingME

& NetBeans DataBindingME PIV
i NetBeans DataBindingME SVC

-~ NetBeans MIDP Components
i NetBeans MIDP Components

< \_ 1 »

[ New Library... ][ Remove ]

[ OK ][ Cancel

Figure 10-14: Liste des fichiers pour JMS

Les boutons « Move Up » et « Move Down » permettent d’agencer I’ordre des fichiers tel que
nous I’avons décrit plus haut.

Cliquez sur le bouton OK pour appliquer vos modifications.

Maintenant que la librairie JMS est préte a I’emploi, vous allez ajouter sa référence au projet
Yaps-Client.

Ouvrez les propriétés du projet Yaps-Client et s€lectionnez la catégorie « Libraries » :
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r B
O Project Properties - Yaps-Client I lij
Categories:
« O Sources Java Platform: | JDK 1.6 (Default) v | | Manage Platforms...
i O Libraries

+- @ Compiling -
| i o Ppackaging Compile | Run | Compile Tests | Run Tests|
||
I ~ @ Documenting Compile-time Libraries:

@ =
| Groovy ../Yaps-Server build/Yaps-Server-ejb. jar Add Project...
'l i '} Run‘ ) ../Tools/Lib/commons-ang-2.3.jar -
1l &~ @ Appication ../Tools/Lib/vstm-xscore-0.5.0.jar fdd Lubrary..

- @ Web Start e
: i @ Formatting
|| Edit
|
|| Remove
|
|| Move Up
| Move Down
|
| |
I
|
| L ’ )
i Compile-time libraries are propagated to all library categories.

Build Projects on Classpath
OK ][ Cancel ” Help ]

\ e

Figure 10-15: Propriés du projet

Cliquez sur le bouton « Add Library » :
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[ © Add Library (S5

Available Libraries:

----- & Java ME CDC AGUI Free Layout -

----- &) Java ME CDC NSIcom Plugin Implemenl
----- &) Java ME CDC Personal Profile Free Lay
----- &) Java Tree API

m

vvvvv i JDBC Design-Time Support - Deprecate
---- i JDBC Run-Time Support - Deprecated
----- & Jersey 0.8 (JAX-RSRI)

..... =

----- & IMUNit4CLDC10

----- & IMUnit4CLDC11

----- i JSF 1.1/1.2 Support

G v 4 4 el Tieee Fiimmeik Pheme e

L« | m | )

f [ Add Library ][ Cancel ]

Figure 10-16: Référence a la librairie JMS

Dans la liste des librairies, sélectionnez « JMS » et cliquez sur le bouton « Add Library » :
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r Y
O Project Properties - Yaps-Client [ &J
Categories:
- O Sources Java Platform: |JDK 1.6 (Default) v | | Manage Platforms...
- © Libraries
@ Compiling Compil
ompile i
. 0 Packaging pi IRunICompdeTestsIRunTestsl
||
- @ Documenting Compile-time Libraries:

| -~ @ Groov
'l i ¥ @ ../Yaps-Server build/Yaps-Server-gjb.jar Add Project...
] i ) Runl ) @ ../Tools/Lib/commons-ang-2.3.jar -
'l &~ @ Application ../Tools/Lib/vstm-xscore-0.5.0.jar Add Library...

| o Webse Add 1R [Folde
: .. @ Formatting ’
\
||
!
||
.
| Move Down
|
I |
I
|
: Compile-time libraries are propagated to all library categories.

Build Projects on Classpath
’ OK ][ Cancel H Help
| e
Figure 10-17: Librairie JMS dans le projet

Cliquez sur « OK ».

La librairie JMS est maintenant référencée dans le projet Yaps-Client.
NetBeans va automatiquement compiler le projet et résoudre les références manquantes.

A ce stade, plus aucune erreur ne doit étre détectée dans le projet :
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: Projects a8 | : Files

: Servic

= f3 Source Packages

-5 com.yaps.petstore.client.delegate

-5 com.yaps.petstore.client.locator
EE] com.yaps.petstore. client.ui

EEl com.yaps.petstore. client.ui.order
EEl com.yaps.petstore. client. ui.util

‘B com.yaps.petstore.client.util.jms
Test Packages

Libraries

-
G-

Test Libraries

-5 com.yaps.petstore.client.ui.customer

-5 com.yaps.petstore.client.ui.util.event

-5 com.yaps.petstore.client.ui.catalog.category

-5 com.yaps.petstore.client.ui.catalog.category.event
- com.yaps.petstore.client.ui.catalog.category.model
-5 com.yaps.petstore.client.ui.catalog.item

-5 com.yaps.petstore.client.ui.catalog.item.event
-5 com.yaps.petstore.client.ui.catalog.item.model
- com.yaps.petstore.client.ui.catalog.product

-5 com.yaps.petstore.client.ui.catalog.product.event
-5 com.yaps.petstore.client.ui.catalog.product.model
-5 com.yaps.petstore.client.ui.common.address

- com.yaps.petstore.client.ui.common. address.event
- com.yaps.petstore.client.ui.common. address.model

-5 com.yaps.petstore.client.ui.customer.event
-5 com.yaps.petstore.client.ui.customer.model

-i55 com.yaps.petstore.client.ui.order.event
i com.yaps.petstore.client.ui.order.model

-5 com.yaps.petstore.client.ui.util.combo

Figure 10-18: Résolution des problémes

10.2.3.4 Référencer les librairies TopLink

Durant la phase d’exécution du I’application Yaps-Client, des objets de type Entity sont
manipulés pour lesquelles les classes du framework TopLink sont requises.

Vous allez référencer les classes du framework TopLink pour éviter les erreurs d’exécution.

Ouvrez les propriétés du projet et sélectionnez la catégorie « Libraries » :
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O Project Properties - Yaps-Client

Categories:

- @ Sources
o
5. Build
; Compiling

Packaging
Documenting
Groovy
Run
Application
O Web Start
Formatting

Java Platform: JDK 1.6 (Default)

Libraries Folder:

Compile | Run | Compile Tests | Run Tests |

I===)

Compile-time Libraries:

@ ../Yaps-Server build/Yaps-Server-ejb.jar
../Tools/Lib/commons-ang-2.3.jar
../Tools/Lib/vstm-xscore-0.5.0.jar

= Ms

Add Project...
A

Add JAR /Folder
Edit
Remove

Move Up

Move Down

Compile-time libraries are propagated to all library categories.

Build Projects on Classpath

Figure 10-19: Librairies du projet

Cliquez sur le bouton “Add Library” et sélectionnez la librairie TopLink Essentials :
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[ Add Library (S

Available Libraries:

----- B rrokuara voruscacor |
‘
&) Ricoh Build System Ant Utilities

----- &) Savale Build System Ant Utilities

----- i Sony Ericsson Build System Ant Utilities
----- &) Spring Framework 2.5

..... & SpringWebMVC 2.5

----- B Struts1.2.9

----- i Sun Web UI Components Design-Time
----- ﬁ Sun Web UI Components Run-Time Suj
----- i Sun Web UI Components Support

----- i Swing Application Framework

----- &) Swing Layout Extensions

----- =

----- & Web UI Components

vvvvv &) Web UI Default Theme
< | i | ’

m

1 |

[ Add Library H Cancel ] \

Figure 10-20: Libraire TopLink Essentials

Cliquez sur « Add Library ».

Cliquez ensuite sur OK afin d’ajouter la référence de la libraire TopLink :
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r b |
O Project Properties - Yaps-Client ][ llj
Categories:
« @ Sources Java Platform: |JDK 1.6 (Default) v | | Manage Platforms...
i @ Libraries :

- @ Compiling > -

- & Packaging Compile | Run | Compile Tests | Run Tests|
l |
| © Documenting Compile-time Libraries:
I ) ; Groovy ../Yaps-Server build/Yaps-Server-ejb.jar Add Project...

@ Run ] .

1l e @ ../Tools/Lib/commons-lang-2.3.jar -
i &~ @  Application 5 ../Tools/Libjvstm-xscore-0.5.0.jar Add Library...

- ©  Web Start
i o Formattn = s Add JAR /Folder
1l 9 =" Toplink Essentials
|
||
:
|
.
1 Move Down
)
1 i
|
|
: Compile-time libraries are propagated to all library categories.

| Build Projects on Classpa
[¥] Build | th
[ OK I%’ Cancel H Help ]
[ |
|\ e
Figure 10-21: Référence a TopLink Essentials

10.2.4 Identifier la classe principale

Avant de tester 1’application, il vous reste a localiser la classe principale « Main Class » qui
sera invoquée a 1’exécution.

Ouvrez les propriétés du projet et rendez-vous sur la catégorie « Run » :
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r - B
O o . =
p oo

Categories:

S r
ources Configuration: | <default config>

Libraries
> Build
) Compiling
w O Packaging
.. O Documenting Arguments:
3

Main Class:

: Groovy
N m Working Directory:
Application VM Options:
-~ O Web Start (e.g. -Xms10m)
Formatting

Run with Java Web Start
(To run and debug the application with Java Web Start, first enable Java Web Start)

Figure 10-22: Propriétés du projet (Run)

Le champ « Main Class » permet d’identifier la classe principale.

Cliquez sur le bouton « Browse » pour sélectionner la classe principale
« com.yaps.petstore.client.ui.PetstoreFrame » :
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( 0 Browse Main Classes &

Main classes:

com.yaps.petstore.client.ui.PetstoreFrame

Select Main Class ] [ Cancel

3

Figure 10-23: Sélection de la classe principale

Cliquez sur le bouton « Select Main Class ».

Cliquez ensuite sur OK afin de sauver vos modifications dans les propriétés du projet :
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Crrre o I =
Categories:
[0 Sources § r i
) Configuration: | <default config>
@ Libraries .
| B @ Build
- @ Compling Main Class: com.yaps.petstore. dient.ui.PetstoreFrame
- @ Packaging
- @ Documenting Arguments:
- @ Groovy
i @ RuUn Working Directory:
- © Application VM Options:
e 0 WebsStart (e.g. Xms10m)
i O Formatting

Run with Java Web Start
(To run and debug the application with Java Web Start, first enable Java Web Start)

Figure 10-24: Classe principale identifiée

10.2.5 Créer le groupe de projet

A partir du menu « File » ou via un clic droit dans la fenétre « Projects », NetBeans offre la
capacité de créer le nouveau groupe de projet :

New Project... Ctrl+Shift+N
New File...
Open Project... Ctrl+Shift+ 0
Open Recent Project »
Project Group » BarkBank
- - - PetEx
Build Main Project F11
. . . . Yaps-Server
Clean and Build Main Project  Shift+F11
@ (none)
Run Main Project F6
. . New Group...
Debug Main Project Ctrl+F5 !}
Set Main Project »
View Java Packages as »

Figure 10-25: Créer un groupe de projet
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Sélectionnez I’option « New group ».

La fenétre suivante permet de nommer le groupe de projet qui est dans notre cas « Yaps—
Client » :

Name: |Yaps-Client

@ Free Group
Contains any projects you like. Can be updated manually or automatically.
Use Currently Open Projects

Automatically Save Project List
(7) Project and All Required Projects
Contains a master project and all projects it requires, recursively.
Master Project:
(7) Folder of Projects
Contains any projects found beneath a given folder on disk.

Folder:

Create Group % [ Cancel

Figure 10-26: Nouveau groupe de projet

Les options par défaut indiquent que les projets en cours de chargement dans I’IDE seront
automatiquement ajoutés au groupe de projet.

Cliquez sur le bouton « Create Group ».

10.3 Compiler le projet

Un clic droit sur le projet fait apparaitre le menu contextuel proposant les options pour
compiler le projet (« Build » ou « Clean and Build ») :

Projects - YapsOn ... < |5Files

§ |

- New »
-
- Build
&- ﬂ Clean and Build
Clean
Generate Javadoc

Figure 10-27: Compiler le projet
Cliquez sur I’option « Clean and Build ».

La fenétre « Output » affiche les traces de la compilation :
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: Qutput - Yaps-Client (clean,jar) % & |: JUnit Test Results
u> C: Projects YapsCON' Yaps-Client'src . com'yvaps ' petstore'client util' qms  Jn

* Lib?re toutes les ressources JMS utilis?es.
Ei C: " Projects YapsON' Yaps-Client'src' com'yvaps ' petstore'client util' qms " Jn

* Lib?re toutes les ressources JMS utilis?es.
C: " Projects YapsON' Yaps-Client'src' com'yvaps ' petstore'client util’ qms " Jn

* D?marre la r?ception des messages.

(]

‘Projects YapsON' Yaps-Client ' src' com' yvaps'petstore'client ' util’ ims  Jm

* D?marre la r?ception des messages.
C: " Projects YapsON' Yaps-Client src' com'vaps ' petstore'client util’ qms " Jn

* Arr?te la r?ception des messages.
C: " Projects YapsON' Yaps-Client src' com'yvaps ' petstore'client util' qms " Jn

* Arr?te la r?ception des messages.
2& warnings
Copying 1 file to C:'Projects YapsON' Yaps-Client'build'classes
compile:
Created dir: C:“Projects YapsON'Yaps-Client'dist
Building jar: C:“Projects YapsON'Yaps-Client'dist Yaps-Client.jar
Copy libraries to C:'Projects YapsON'Yaps-Client'dist’lib.
To run this application from the command line without Ant, try:
java -jar "C:"Projects ' YapsON'. Yaps-Client'dist Yaps-Client.jar"
jar:
BUILD SUCCESSFUL (total time: & secondsd

Figure 10-28: Résultat de la compilation

En analysant en détail les traces de la compilation, on reléve les messages suivants :

Building jar: C:\Projects\YapsON\Yaps-Client\dist\Yaps-Client.jar

To run this application from the command line without Ant, try:

java -jar "C:\Projects\YapsON\Yaps-Client\dist\Yaps-Client.jar"

BUILD SUCCESSFUL (total time: 6 seconds)

Ces traces indiquent que 1’application Yaps-Client a été correctement compilée et qu’il est
possible de I’exécuter a partir de la ligne de commande en invoquant la commande suivante :

java -jar {yapson home}\Yaps-Client\dist\Yaps-Client.jar

10.4 Tester le projet

Nous allons décrire les spécificités de NetBeans en matieére d’exécutions d’applications Java.

10.4.1 Démarrer le serveur PetStore

Avant de démarrer 1’application Yaps-Client, il est nécessaire de démarrer le serveur
« PetStore ».

Rendez-vous sur I’onglet « Services » et démarrez le serveur PetStore :
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: Projects - Ya... | Files

|E Services U &

- & Databases
-9® web Services
-& Enterprise Beans (2.x)

Servers
1}}% Apache Tomcat 6.0.18

@-C GlassFish V2
- GlassFish V3

N OflF=tstore

3]

[ WEBric Start
St]%in Debug Mode

Start in Profile Mode

Figure 10-29: Démarrez le serveur PetStore

10.4.2 Exécuter I'application Yaps-Client

Sous NetBeans, I’application Yaps-Client peut-étre démarrée de différentes fagons :

En appuyant sur la touche « F6 »

A partir du menu « Run — Run Main project » :

|Run| Profile Versioning Tools Window Help

7 P RunMain Project Fé
D Debug Main Project Ctrl+F5
Test "Yaps-Client" Alt+F6

Run File

»

A partir de I’option « Run » du menu contextuel du projet :

: Projects -... < % | Files [ Services
tl@
-- {3 Sou New >
- Tesj
@ B Libr Build
&- e TESJ Clean and Build
Clean
Generate Javadoc
Run
ug
Profile
Test Alt+F6
Set Configuration »

* A partir de la barre d’outils en cliquant sur I’icone suivant : |>
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L’application apparait a I’écran :
r[éj Pet Store @@g

File Customer Catalog Order Look&Feel

[ Lists all the customers e 2 B e E X
ID First Name LastName |Telephone Email City Country

1 Marc Fleury 545123 45|marc@jboss.org  |Los Ange...|USA

2 Bill Gates 654 046 12|bill.gates@micros... Alhabama |USA

3 Steve Jobs 548 157 15|steve jobs@apple...|San Fran... [USA

4 Antonio Goncalves 437 487 21|antonio.goncalves...|Oakland  |USA

101 Said Eloudrhiri said.eloudrhiri@yi... LIEGE BE

’ Find ‘ | Create | | View ‘ ‘ Update ‘ ‘ Delete ‘ I Close |

Figure 10-30: Application Yaps-Client

Reportez-vous au livre de référence qui décrit les fonctionnalités de 1’application client.

4
S’abonner au topic JMS

Pour recevoir les messages postés dans la file d’attente JMS (les articles de type
« reptiles »), n’oubliez pas de vous abonner au topic JMS en ouvrant la fenétre « Watch
orders » disponible sous le menu « Order ».

L’application cliente ne gére pas la notion de durabilité des messages JMS.
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La barre de statut de NetBeans (en bas et a droite) affiche le statut de 1’application en cours
d’exécution :

Yaps-Client (run) | FUNRING s+ ‘

Pour stopper 1’exécution de 1’application, un clic droit sur la barre de statut propose un menu
contextuel permettant de stopper 1’application :

Show Processes

Show Qutput
Yaps-Client (run) | Cancel Process

Figure 10-31: Annuler I'exécution

Problémes d'accés aux données

Un probléme d'acces aux données (catégories, commandes, etc.) peut survenir si
l'application cliente a été compilée avec des librairies Toplink Essentials différentes de celle
du serveur.

Dans ce cas, 'application client fera apparaitre une erreur similaire a celle-ci:

8.N0.0 Error

org.omg.CORBA.MARSHAL: vmcid: SUN minor code: 211 completed: Maybe

o nested exception is: java.rmi.MarshalException: CORBA MARSHAL 1398079699 Maybe; nested exception is:

[ OK

La console indiquera une erreur semblable a la suivante:

Caused by: java.io.IOException: Mismatched serialization UIDs : Source (Rep.
IDRMI:oracle.toplink.essentials.indirection.IndirectList:C736541957C385C5:7070E88CAC21B40B)
= T7070E88CAC21B40B whereas Target (Rep. ID
RMI:oracle.toplink.essentials.indirection.IndirectList:C736541957C385C5:8CE233D0CA77EED4) =
8CE233D0CA77EED4

La cause de I'erreur une inconsistance entre la signature de sérialisation entre I'objet sur le
serveur et celui du client (Mismatched serialization UIDs).
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Dans notre cas, ce probléme est apparu, car I'application serveur (Yaps-Server) a été
déployée sur une version GlassFish v2.1 livrée en bundle avec "GlassFish ESB" (Netbeans
6.5.1) alors que le client a été compilé avec des ressources TopLink Essentials livrées avec

NetBeans 6.7.1.

[ Compile Run Compile Tests  Run Tests |

Compile-time Libraries:

2] ../Yaps-Server/build /Yaps-Server-ejb.jar
& ../Tools/Lib/commons-lang-2.3.jar
2 ../Tools/Lib /vstm-xscore-0.5.0.jar [ Add Library...

= IS p N
= TopLink Essentials [ Add JAR/Folder

Add Project...

Pour éviter le probléme, il a donc fallu ajouter au programme client (Yaps-Client) les
libraires TopLink Essentials du serveur et non celles définies par défaut nous NetBeans:

( Compile Run  Compile Tests Run Tests |

Compile-time Libraries:

fj ../Yaps-Server/build/Yaps-Server-ejb.jar
fj ../Tools/Lib/commons-lang-2.3.jar
o] ../Tools/Libjvstm-xscore-0.5.0.jar

= )ms
8 /Users/eloudsa/GlassFishESBv2 1 /glassfish/lib/toplink-essentials.jar ( Add JAR/Folder

Add Project...

(" Add Library...

/Users/eloudsa/GlassFishESBv2 1/glassfish/lib /toplink-essentials-agent.jar

10.5 Conclusion

Les sources du client de 1’application « Yaps» ont été transférées sous NetBeans dans une
arborescence conforme au format préconisé¢ par le Java Blueprints.

Les tests que nous avons réalisés attestent que 1’application cliente Swing communique
correctement avec les composants déployés sur le serveur.
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11 Conclusion

Nous voila arrivés au terme de ce document.

Vous étes maintenant en mesure d’utiliser I’application Yaps Pet Store sous NetBeans et
d’approfondir vos connaissances de JEES en bénéficiant de la richesse et de la souplesse de
NetBeans 6.5.x/6.7.x.

Couplé au livre de référence, vous étes paré a vous lancer dans 1’élaboration d’application
JEES ou de réaliser des POC (Proof Of Concept) nettement plus riches qu’un simple « Hello
World ». L’application Yaps Pet Store peut servir d’excellent point de départ pour vos
expérimentations.

Bien entendu, nous n’avons qu’effleuré les différentes facettes de NetBeans. Le site
www.netbeans.org vous sera d’un grand secours tant les informations qui s’y trouvent sont
nombreuses.

Et maintenant, a vous de jouer !
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13 Glossaire

DB DataBase

EAR Enterprise Archive

EJB Enterprise JavaBean

ESB Enterprise Servive Bus

IDE Integrated Development Environment
JAR Java ARchive

Java SE | Java Standard Edition

JAX-WS | Java API for XML Web Services
JDBC Java DataBase Connectivity

JDK Java Development Kit

JEE Java Enterprise Edition

JEES Java Enterprise Edition version 5
JMS Java Message Service

JPA Java Persistance API

JSF JavaServer Faces

JVM Java Virtual Machine

POC Proof of Concept

SOA Service Oriented Architecture

SQL Structured Query Language

URI Uniform Resource Identifier

URL Uniform Resource Locator

WAR Web Application aRchive

WSDL Web Service Description Language
YapsON | Yaps Pet Store On NetBeans
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